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Thank you for purchasing the AQ1300/AQ1301 ETHERNET Multi Field Tester.
This user’s manual explains the features, operating procedures, and handling precautions of the 
AQ1300/AQ1301 setup software. To ensure correct use, please read this manual thoroughly before 
operation. Keep this manual in a safe place for quick reference in the event that a question arises.
This manual is one of five AQ1300/AQ1301 manuals. Please read all the manuals.

List of Manuals
Manual Title Manual No. Description
AQ1300/AQ1301 ETHERNET  
Multi Field Tester Operation Guide

IM AQ1300-02EN This guide focuses on the handling precautions, 
basic operations, and specifications of the AQ1300/
AQ1301.

AQ1300/AQ1301 ETHERNET  
Multi Field Tester User’s Manual 
(included in CD)

IM AQ1300-01EN This manual explains all the AQ1300/AQ1301 
features and how to use them.

AQ1300/AQ1301 ETHERNET  
Multi Field Tester Communication Interface 
User’s Manual 
(included in CD)

IM AQ1300-17EN The manual explains the AQ1300/AQ1301 
communication interface features and instructions on 
how to use them.

AQ1300 MFT 10GbE Setup Software  
User’s Manual 
(included in CD)

IM AQ1300-61EN This manual. It explains how to use a PC to create 
AQ1300/AQ1301 setup files, display result files, and 
generate CSV files.

AQ1300/AQ1301 Remote Control 
Software User’s Manual (in CD)

IM AQ1300-63EN This manual explains how to remotely control the 
AQ1300/AQ1301 from a PC.

The “-EN” in the manual number is the language code.

Notes
•	 This manual (IM AQ1300-61EN 7th edition) applies to AQ1300/AQ1301 Setup Software 

version R1.10.01.001 and later.
If you are using an older version, you will not be able to use all the features described in this 
manual.
Check the software version of your product with the version information. For information on how to 
view the version information, see section 5.3.

•	 The	contents	of	this	manual	are	subject	to	change	without	prior	notice	as	a	result	of	continuing	
improvements to the instrument’s performance and functionality. The figures given in this manual 
may differ from those that actually appear on your screen.

•	 Every	effort	has	been	made	in	the	preparation	of	this	manual	to	ensure	the	accuracy	of	its	
contents. However, should you have any questions or find any errors, please contact your nearest 
YOKOGAWA dealer.

•	 Copying	or	reproducing	all	or	any	part	of	the	content	of	this	manual	without	the	permission	of	
YOKOGAWA is strictly prohibited.

Trademarks
•	 Microsoft,	Windows,	Windows	XP,	Windows	Vista	and	Windows	7	are	either	registered	trademarks	

or trademarks of Microsoft Corporation in the United States and/or other countries.
•	 Adobe	and	Acrobat	are	trademarks	of	Adobe	Systems	Incorporated.
•	 In	this	manual,	the	®	and	TM	symbols	do	not	accompany	their	respective	registered	trademark	or	

trademark names.
•	 Other	company	and	product	names	are	registered	trademarks	or	trademarks	of	their	respective	

holders.

9th Edition: October 2017 (YMI)
All Rights Reserved, Copyright ©2009, Yokogawa Electric Corporation
All Rights Reserved, Copyright ©2010, Yokogawa Test & Measurement Corporation
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Terms and Conditions of the Software License

Yokogawa Electric Corporation and Yokogawa Test & Measurement Corporation, Japanese corporations (hereinafter called “Yokogawa”), grant permission to use this 
Yokogawa Software Program (hereinafter called the “Licensed Software”) to the Licensee  on the conditions that the Licensee agrees to the terms and conditions stipulated 
in Article 1 hereof. 
You, as the Licensee (hereinafter called “Licensee”), shall agree to the following terms and conditions for the software license (hereinafter called the “Agreement”) based 
on the use intended for the Licensed Software.  
Please note that Yokogawa grants the Licensee permission to use the Licensed Software under the terms and conditions herein and in no event shall Yokogawa intend to 
sell or transfer the Licensed Software to the Licensee.
Licensed Software Name: AQ1300 MET10GbE Setup Software
Number of Licenses:  Unlimited

Article 1 (Scope Covered by these Terms and Conditions)
1.1 The terms and conditions stipulated herein shall be applied to any Licensee who purchases the Licensed Software on the condition that the Licensee consents to 

agree to the terms and conditions stipulated herein.
1.2 The “Licensed Software” herein shall mean and include all applicable programs and documentation, without limitation, all proprietary technology, algorithms, and know-

how such as a factor, invariant or process contained therein.

Article 2 (Grant of License)
2.1 Yokogawa grants the Licensee, for the purpose of single use, non-exclusive and non-transferable license of the Licensed Software with the license fee separately 

agreed upon by both parties.  
2.2 The Licensee is, unless otherwise agreed in writing by Yokogawa, not entitled to copy, change, sell, distribute, transfer, or sublicense the Licensed Software.
2.3 The Licensed Software shall not be copied in whole or in part except for keeping one (1) copy for back-up purposes.  The Licensee shall secure or supervise the copy 

of the Licensed Software by the Licensee itself with great, strict, and due care. 
2.4 In no event shall the Licensee dump, reverse assemble, reverse compile, or reverse engineer the Licensed Software so that the Licensee may translate the Licensed 

Software into other programs or change it into a man-readable form from the source code of the Licensed Software.  Unless otherwise separately agreed by 
Yokogawa, Yokogawa shall not provide the Licensee the source code for the Licensed Software. 

2.5 The Licensed Software and its related documentation shall be the proprietary property or trade secret of Yokogawa or a third party which grants Yokogawa the rights.  
In no event shall the Licensee be transferred, leased, sublicensed, or assigned any rights relating to the Licensed Software.

2.6 Yokogawa may use or add copy protection in or onto the Licensed Software.  In no event shall the Licensee remove or attempt to remove such copy protection.
2.7 The Licensed Software may include a software program licensed for re-use by a third party (hereinafter called “Third Party Software”, which may include any software 

program from affiliates of Yokogawa made or coded by themselves.)  In the case that Yokogawa is granted permission to sublicense to third parties by any licensors 
(sub-licensor) of the Third Party Software pursuant to different terms and conditions than those stipulated in this Agreement, the Licensee shall observe such terms 
and conditions of which Yokogawa notifies the Licensee in writing separately.

2.8 In no event shall the Licensee modify, remove or delete a copyright notice of Yokogawa and its licenser contained in the Licensed Software, including any copy thereof.

Article 3 (Restriction of Specific Use)
3.1 The Licensed Software shall not be intended specifically to be designed, developed, constructed, manufactured, distributed or maintained for the purpose of the 

following events:
a) Operation of any aviation, vessel, or support of those operations from the ground;,
b) Operation of nuclear products and/or facilities;,
c) Operation of nuclear weapons and/or chemical weapons and/or biological weapons; or
d) Operation of medical instrumentation directly utilized for humankind or the human body.

3.2 Even if the Licensee uses the Licensed Software for the purposes in the preceding Paragraph 3.1, Yokogawa has no liability to or responsibility for any demand or 
damage arising out of the use or operations of the Licensed Software, and the Licensee agrees, on its own responsibility, to solve and settle the claims and damages 
and to defend, indemnify or hold Yokogawa totally harmless, from or against any liabilities, losses, damages and expenses (including fees for recalling the Products 
and reasonable attorney’s fees and court costs), or claims arising out of and related to the above-said claims and damages.

Article 4 (Warranty)
4.1 The Licensee shall agree that the Licensed Software shall be provided to the Licensee on an “as is” basis when delivered.  If defect(s), such as damage to the medium 

of the Licensed Software, attributable to Yokogawa is found, Yokogawa agrees to replace, free of charge, any Licensed Software on condition that the defective 
Licensed Software shall be returned to Yokogawa’s specified authorized service facility within seven (7) days after opening the Package at the Licensee’s expense.  As 
the Licensed Software is provided to the Licensee on an “as is” basis when delivered, in no event shall Yokogawa warrant that any information on or in the Licensed 
Software, including without limitation, data on computer programs and program listings, be completely accurate, correct, reliable, or the most updated. 

4.2 Notwithstanding the preceding Paragraph 4.1, when third party software is included in the Licensed Software, the warranty period and terms and conditions that apply 
shall be those established by the provider of the third party software. 

4.3	 When	Yokogawa	decides	in	its	own	judgement	that	it	is	necessary,	Yokogawa	may	from	time	to	time	provide	the	Licensee	with	Revision	upgrades	and	Version	
upgrades separately specified by Yokogawa (hereinafter called “Updates”).

4.4 Notwithstanding the preceding Paragraph 4.3, in no event shall Yokogawa provide Updates where the Licensee or any third party conducted renovation or 
improvement of the Licensed Software.

4.5	 THE	FOREGOING	WARRANTIES	ARE	EXCLUSIVE	AND	IN	LIEU	OF	ALL	OTHER	WARRANTIES	OF	QUALITY	AND	PERFORMANCE,	WRITTEN,	ORAL,	OR	
IMPLIED, AND ALL OTHER WARRANTIES INCLUDING ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE ARE 
HEREBY DISCLAIMED BY YOKOGAWA AND ALL THIRD PARTIES LICENSING THIRD PARTY SOFTWARE TO YOKOGAWA.

4.6 Correction of nonconformity in the manner and for the period of time provided above shall be the Licensee’s sole and exclusive remedy for any failure of Yokogawa to 
comply with its obligations and shall constitute fulfillment of all liabilities of Yokogawa and any third party licensing the Third Party Software to Yokogawa (including any 
liability for direct, indirect, special, incidental or consequential damages) whether in warranty, contract, tort (including negligence but excluding willful conduct or gross 
negligence by Yokogawa) or otherwise with respect to or arising out of the use of the Licensed Software.

Article 5 (Infringement)
5.1	 If	and	when	any	third	party	should	demand	injunction,	initiate	a	law	suit,	or	demand	compensation	for	damages	against	the	Licensee	under	patent	right	(including	utility	

model right, design patent, and trade mark), copy right, and any other rights relating to any of the Licensed Software, the Licensee shall notify Yokogawa in writing to 
that effect without delay.

5.2 In the case of the preceding Paragraph 5.1, the Licensee shall assign to Yokogawa all of the rights to defend the Licensee and to negotiate with the claiming party.  
Furthermore, the Licensee shall provide Yokogawa with necessary information or any other assistance for Yokogawa’s defense and negotiation.  If and when such a 
claim	should	be	attributable	to	Yokogawa,	subject	to	the	written	notice	to	Yokogawa	stated	in	the	preceding	Paragraph	5.1,	Yokogawa	shall	defend	the	Licensee	and	
negotiate	with	the	claiming	party	at	Yokogawa’s	cost	and	expense	and	be	responsible	for	the	final	settlement	or	judgment	granted	to	the	claiming	party	in	the	preceding	
Paragraph 5.1.

5.3	 When	any	assertion	or	allegation	of	the	infringement	of	the	third	party’s	rights	defined	in	Paragraph	5.1	is	made,	or	when	at	Yokogawa’s	judgment	there	is	possibility	of	
such assertion or allegation, Yokogawa will, at its own discretion, take any of the following countermeasures at Yokogawa’s cost and expense.
a) To acquire the necessary right from a third party which has lawful ownership of the right so that the Licensee will be able to continue to use the Licensed Software;
b) To replace the Licensed Software with an alternative one which avoids the infringement; or
c) To remodel the Licensed Software so that the Licensed Software can avoid the infringement of such third party’s right.

5.4 If and when Yokogawa fails to take either of the countermeasures as set forth in the preceding subparagraphs of Paragraph 5.3, Yokogawa shall indemnify the 
Licensee only by paying back the price amount of the Licensed Software which Yokogawa has received from the Licensee.  THE FOREGOING PARAGRAPHS STATE 
THE ENTIRE LIABILITY OF YOKOGAWA AND ANY THIRD PARTY LICENSING THIRD PARTY SOFTWARE TO YOKOGAWA WITH RESPECT TO INFRINGEMENT 
OF THE INTELLECTUAL PROPERTY RIGHTS INCLUDING BUT NOT LIMITED TO, PATENT AND COPYRIGHT.
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Article 6 (Liabilities)
6.1 If and when the Licensee should incur any damage relating to or arising out of the Licensed Software or service that Yokogawa has provided to the Licensee under the 

conditions herein due to a reason attributable to Yokogawa, Yokogawa shall take actions in accordance with this Agreement.  However, in no event shall Yokogawa 
be liable or responsible for any special, incidental, consequential and/or indirect damage, whether in contract, warranty, tort, negligence, strict liability, or otherwise, 
including, without limitation, loss of operational profit or revenue, loss of use of the Licensed Software, or any associated products or equipment, cost of capital, loss 
or cost of interruption of the Licensee’s business, substitute equipment, facilities or services, downtime costs, delays, and loss of business information, or claims of 
customers of Licensee or other third parties for such or other damages. Even if Yokogawa is liable or responsible for the damages attributable to Yokogawa and to the 
extent of this Article 6, Yokogawa’s liability for the Licensee’s damage shall not exceed the price amount of the Licensed Software or service fee which Yokogawa has 
received.  Please note that Yokogawa shall be released or discharged from part or all of the liability under this Agreement if the Licensee modifies, remodels, combines 
with other software or products, or causes any deviation from the basic specifications or functional specifications, without Yokogawa’s prior written consent.

6.2 All causes of action against Yokogawa arising out of or relating to this Agreement or the performance or breach hereof shall expire unless Yokogawa is notified of the 
claim within one (1) year of its occurrence.

6.3 In no event, regardless of cause, shall Yokogawa assume responsibility for or be liable for penalties or penalty clauses in any contracts between the Licensee and its 
customers.

Article 7 (Limit of Export)
Unless otherwise agreed by Yokogawa, the Licensee shall not directly or indirectly export or transfer the Licensed Software to any countries other than those where 
Yokogawa permits export in advance.

Article 8 (Term)
This Agreement shall become effective on the date when the Licensee receives the Licensed Software and continues in effect unless or until terminated as provided herein, 
or the Licensee ceases using the Licensed Software by itself or with Yokogawa’s thirty (30) days prior written notice to the Licensee.

Article	9	(Injunction	for	Use)
During	the	term	of	this	Agreement,	Yokogawa	may,	at	its	own	discretion,	demand	injunction	against	the	Licensee	in	case	that	Yokogawa	deems	that	the	Licensed	Software	
is used improperly or under severer environments other than those where Yokogawa has first approved, or any other condition which Yokogawa may not permit.

Article 10 (Termination)
Yokogawa, at its sole discretion, may terminate this Agreement without any notice or reminder to the Licensee if the Licensee violates or fails to perform this Agreement.  
However, Articles 5, 6, and 11 shall survive even after the termination.

Article 11 (Jurisdiction)
Any dispute, controversies, or differences between the parties hereto as to interpretation or execution of this Agreement shall be resolved amicably through negotiation 
between the parties upon the basis of mutual trust.  Should the parties fail to agree within ninety (90) days after notice from one of the parties to the other, both parties 
hereby	irrevocably	submit	to	the	exclusive	jurisdiction	of	the	Tokyo	District	Court	(main	office)	in	Japan	for	settlement	of	the	dispute.

Article 12 (Governing Law)
This Agreement shall be governed by and construed in accordance with the laws of Japan. The Licensee expressly agrees to waive absolutely and irrevocably and to the 
fullest extent permissible under applicable law any rights against the laws of Japan which it may have pursuant to the Licensee’s local law.

Article 13 (Severability)
In	the	event	that	any	provision	hereof	is	declared	or	found	to	be	illegal	by	any	court	or	tribunal	of	competent	jurisdiction,	such	provision	shall	be	null	and	void	with	respect	
to	the	jurisdiction	of	that	court	or	tribunal	and	all	the	remaining	provisions	hereof	shall	remain	in	full	force	and	effect.
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Conventions Used in This Manual

Notes
The notes and cautions in this guide are categorized using the following symbols.

Note Calls attention to information that is important for proper operation of the 
instrument.

Symbols and Conventions Used in Procedural Explanations
The contents of the procedural explanations are indicated using the following symbols.

 Procedure Carry out the procedure according to the step numbers. All procedures are 
written under the assumption that you are starting operation at the beginning 
of the procedure, so you may not need to carry out all the steps in a procedure 
when you are changing the settings.

 Explanation This section describes the setup items and the limitations regarding the 
procedures.

Character Notations
 Bold formatting indicates menus, buttons, etc. that the procedure requires you to click or interface 

terms.

Notes about Using This Software

Storing the CD
Keep the original CD for this software in a safe place. To use this software, install it on a PC hard disk, 
and run it from the PC.

Using the Software
The software may stop functioning when the PC is in standby mode. Disable standby mode when you 
use this software.

About This Manual
This manual contains the following chapters.
Chapter 1 explains test configuration, system requirements, and software features and screens.
Chapter 2 explains how to start and close the software.
Chapter 3 explains the basic operations for configuring items and how to use the features that are only 
available in the setup software.
Chapter 4 explains file operations.
Chapter 5 explains screen operations.
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1.1 Test Configuration

Interaction between the Setup Software and the AQ1300/AQ1301
Create a test scenario with the setup software PC application, and then save the scenario to a setup 
file. Upload the saved setup file to the AQ1300/AQ1301 (AQ1300 and AQ1301), and then use the test 
scenario to perform a test. The test results are saved to a result file. Use the PC to download the result 
file, and then use the setup software to print a report.
You can upload and download files using the Ethernet (FTP), USB storage media, and USB memory.

 

Setup file

Result fileReport

Upload/download

Download

Setup Software
(Windows APP)

Setting 
configuration

Result displayReport output

• After loading a setup file, begin measurement simply by pressing START.
• You can also change the parameters based on the loaded settings.

AQ1300/AQ1301

AQ1300/AQ1301

PC

 

C
reate a test scenario. 

• Ping test 
• B

ER
T 

• Q
oS test 

• Traffic test 

(These items can be executed in order automatically.) 

Save a m
easurem

ent setup file. 

Transfer a m
easurem

ent setup file. 

Select a m
easurem

ent setup file. 

Select a test item
. 

C
hange the test param

eters (if necessary). 

Judge the m
easurem

ent results. 

A
utom

atically save the m
easurem

ent results. 

End testing. 

Send the report of the m
easurem

ent results. 

C
reate a report of the m

easurem
ent results. 

Operation Example (for Auto Mode) 

Setup software 
operations 

AQ1300/AQ1301 operations Setup software 
operations 

For information on how to operate the AQ1300/AQ1301, see the user’s manual, IM AQ1300-01EN.

Chapter 1 Features
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System Requirements
PC
CPU: 1 GHz or higher
Memory: 256 MB or more
HDD: 500 MB free space or more
CD drive (required when installing the software)

Display
XGA	(1024	×	768	pixels)	or	higher

Operating System
Windows	XP,	Windows	Vista,	or	Windows	7

Communication Ports
•	 Ethernet
	 An	Ethernet	port	that	supports	10BASE-T	or	100BASE-TX
•	 USB
 A USB port that supports USB Revision 1.1 or higher

1.1  Test Configuration
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1.2 List of Features

The following table shows the differences between the setup software’s test items and the settings that 
can be made on the AQ1300/AQ1301.

Common Settings
Software: The setup software. A: Auto test. R: Auto(Remote) test. M: Manual test.

Yes: Supported. No: Not supported.
Feature Description Software AQ

1300 
Series

Test Mode
A R M

Port settings Source Test settings
•	Test	interface Yes Yes Yes Yes
•	Test	layer
•	Add	UDP	to	Tx	frame Yes Yes No Yes
•	Use	jumbo	frame
Link settings
•	Negotiation Yes Yes Yes Yes
•	Advertisement No No Yes Yes
•	Speed Yes Yes Yes Yes
•	Duplex
•	Flow	control
•	MDI
•	Configuration	for	Link	partner	acquisition
•	Automatic	RF	response No No Yes Yes
•		Continue	transmission	when	a	linkdown	is	

detected
•	Tx	clock	source1

Address settings
•	MAC	address Yes Yes Yes Yes
•	VLAN
•	IPv4
•	IPv6
•	L4	(UDP	port	number) Yes Yes No Yes
Emulation settings2 No No Yes Yes
•	IPv4
•	IPv6

Destination Test settings
•	Test	interface No Yes No Yes
Link settings
•	Negotiation No Yes No Yes
•	Speed
•	Duplex
•	Flow	control
•	MDI
•	Configuration	for	Link	partner	acquisition
Address settings
•	MAC	address Yes Yes Yes Yes
•	IPv4
•	IPv6
•	L4	(UDP	port	number) Yes Yes No Yes

Table settings MAC address table Number of elements: 1 to 16 Yes Yes Yes No
MAC address 1 to MAC address 16

IPv4 address table Number of elements: 1 to 16 Yes Yes Yes No
IPv4 address 1 to IPv4 address 16

IPv6 address (64 bits) 
table

Number of elements: 1 to 16 Yes Yes Yes No
IPv6 address 1 to IPv6 address 16

Frame length table Number of elements: 1 to 16 Yes Yes Yes No
Frame length 1 to frame length 16
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Feature Description Software AQ
1300 

Series
Test Mode
A R M

Table settings VLAN table Number of elements: 1 to 16 Yes Yes Yes No
VLAN 1 to VLAN 16
•	User	priority	(CoS)
•	VLAN	ID

Tx rate (%) table Number of elements: 1 to 16 Yes Yes Yes No
Tx rate 1 to Tx rate 16

Frames table Number of elements: 1 to 16 Yes Yes Yes No
Send count 1 to send count 16

Tx time table Number of elements: 1 to 16 Yes Yes Yes No
Tx time 1 to Tx time 16

QoS table Number of elements: 1 to 16 Yes Yes Yes No
QoS setting 1 to QoS setting 16
•	CH1	to	CH4:	Used
•	CH1	to	CH4:	QoS
•	CH1	to	CH4:	Frame	length
•	CH1	to	CH4:	Tx	rate

Option settings Advanced settings Select setup file after selecting Auto Yes No No Yes
Allow to change the test setup Yes Yes No Yes
Synchronize measurement and transmission 
controls

Yes Yes Yes Yes

Wait time before starting transmission Yes Yes Yes Yes
Remove test tag from test frame No No Yes Yes
Procedure function Yes Yes No Yes
•	Execution	type
•	First	test	item	number
•	Continuance	confirmation
•	Interval	between	test	items
•	Save	the	file	system3

Measurement settings Measurement start condition Yes Yes Yes Yes
•	Request	ARP/NDP
•		Do	not	start	the	measurement	when	the	link	

is down
Measurement stop condition Yes Yes Yes Yes
•	When	linkdown	is	detected
•	When	an	L2	error	is	detected
•	When	an	L3	error	is	detected
•	When	a	test	fail	judjment	is	detected3 Yes Yes No Yes
Operation after measurement stops Yes Yes No Yes
•	Display	the	judge	pass	or	fail	result
•	Save	measurement	results
•		Save	measurement	results	and	statistics	log No No Yes Yes
Synchronization control setting Yes Yes Yes Yes
•	Try	synchronizing	with	the	other	device
Others3 Yes Yes Yes Yes
•		Subtracting	the	fixed	delay	time	of	the	

opposing
File name settings Results file name File name format Yes Yes Yes Yes

Comment
Specify a directory name
Directory name format
Directory name

Setup file name File name format Yes Yes Yes Yes
Comment

Statistics log 
settings

Statistics log settings Execute statistics logging No No Yes Yes
Execute long logging
Max logging time
Registration setting
Result of Statistics Log are saved3

1.2  List of Features
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Feature Description Software AQ
1300 

Series
Test Mode
A R M

Statistics log 
settings

Statistics log settings Table components No No Yes Yes
•	Items	1	to	4:	Valid	flag
•	Items	1	to	4:	Statistics	group
•	Items	1	to	4:	Statistics	items
•	Items	1	to	4:	Statistics	current3

Statistics display 
items settings

Test result indications Test result setting Yes Yes Yes Yes
•	Rate	unit	switching
•	Traffic	mode	display	switching
•	QoS	mode	display	switching
•	Summary	display	switching

Tx/Rx comparison 
display

Page: 1 and 2; Line: 0 to 19 Yes Yes Yes Yes
•	White	space	identification

Custom display Page: 1 and 2; Line: 0 to 19 Yes Yes Yes Yes
•	White	space	identification
•	Group
•	Item
•	Master/slave

Detailed statistics display Pages: 1 to 32 Yes Yes Yes Yes
•	Identify	blank	pages
•	Group

1 In loopback mode, the operation of the Tx clock source is fixed to operate as the Rx clock, regardless of the 
settings.

2 In loopback mode, the ping and ping6 reply operations are set to OFF, regardless of the settings.
3 This feature is supported in firmware version (FW Ver.) R1.08.01.001 and later.

Select Test Item Settings
Software: The setup software. A: Auto test. R: Auto(Remote) test. M: Manual test.

Yes: Supported. No: Not supported.
Feature Description Software AQ

1300 
Series

Test Mode
A R M

Select test item 
settings

Test items Test name Yes Yes Yes No
Source (test mode) Yes Yes Yes No
Destination (test mode) No Yes No No
Test direction No Yes No No
Test item addition and registration Yes Yes No No

Traffic Auto
Tx rate Tx rate (%) Yes Yes No Yes
Tx mode Tx mode

Number of frames
Time (min)

Frame length Variable frame length setting Yes Yes No Yes
Step
Minimum value
Maximum value
Frame length

Fill pattern Fill pattern Yes Yes No Yes
Pass/fail	judgment	
settings

Link, Tx, Rx Yes Yes No No
•	L1	error:	Link	down	detection
•	L1	error:	LF	or	RF	reception
•	L2	error:	Error	frame	reception
•	L3	error:	Payload	error	detection
•	L3	error:	Sequence	error	detection
•	Incorrect	number	of	bytes
•	Incorrect	number	of	frames
•	Maximum	Rx	rate
•	Average	Rx	rate
•	Maximum	latency	time

1.2  List of Features
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Feature Description Software AQ
1300 

Series
Test Mode
A R M

Traffic Manual
Tx settings Variable frame length setting No No Yes Yes

Variable field setting
Payload check offset setting

Tx rate settings Traffic format No No Yes Yes
Tx rate
Burst setting

Tx mode settings Tx mode No No Yes Yes
Number of frames
Time (s)

Rx settings Oversize threshold No No Yes Yes
Payload error detection
Target frame for statistics
Rx base filter setting

Frame builder Number of frames: 1 No No Yes No
Loopback Loopback settings Loopback target Yes Yes Yes Yes

L4 port number is also switch No No Yes Yes
QoS Auto

Tx mode Tx mode Yes Yes No Yes
Number of frames
Time (min)

Fill pattern Fill pattern Yes Yes No Yes
QoS field Field setting Yes Yes No Yes
Channel setting CH1 to CH4 Yes Yes No Yes

•	Use
•	QoS	pattern
•	Frame	length
•	Tx	rate	(%)

Pass/fail	judgment	
settings

Link, Tx, Rx Yes Yes No No
•	L1	error:	Link	down	detection
•	L1	error:	LF	or	RF	reception
•	L2	error:	Error	frame	reception
•	L3	error:	Payload	error	detection
•	Incorrect	number	of	bytes
•	Incorrect	number	of	frames
•	Maximum	Rx	rate
•	Average	Rx	rate
•	Maximum	latency	time
QoS channel setting: CH1 to CH4 Yes Yes No No
•	L3	error:	Payload	error	detection
•	L3	error:	Sequence	error	detection
•	Incorrect	number	of	bytes
•	Incorrect	number	of	frames
•	Maximum	Rx	rate
•	Average	Rx	rate
•	Maximum	latency	time

Manual
Tx QoS settings Tx channel (1 to 8) No No Yes Yes

•	Tx	rate	(%)
•	Variable	frame	length	setting
•	Tx	rate	setting
Payload check offset setting No No Yes Yes

Tx mode settings Tx mode No No Yes Yes
Number of frames
Time (s)

Rx QoS settings Rx QoS settings No No Yes Yes
Classification type
Channel field setting
Rx channel (1 to 8)
Use CH8 as other channel

1.2  List of Features
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Feature Description Software AQ
1300 

Series
Test Mode
A R M

QoS Rx settings Oversize threshold No No Yes Yes
Payload error detection
Target frame for statistics
Rx base filter setting

Frame builder Number of frames: 8 No No Yes No
Emulate settings Source MAC No No Yes Yes

Destination MAC
IPv4

Ping Destination1 Yes Yes Yes Yes
Source2 No No No No
Auto

Transmission interval Transmission interval Yes Yes No No
Tx mode settings Tx mode

Number of frames
Time (min)

Frame length Frame length Yes Yes No No
Pass/fail	judgment	
settings

Ping settings Yes Yes No No
•	Frame	loss	detection
•	Maximum	response	time

Manual
Tx settings Frame length No No Yes Yes

Tx mode
Number of frames
Time (s)
Transmission interval
Timeout

BERT Auto
Tx rate settings Tx rate (%) Yes No No Yes
Tx mode settings Tx mode

Number of frames
Time (min)

Frame length Frame length
Pass/fail	judgment	
settings

Bit error detection Yes No No No
BART checked byte doesn’t exist

Manual
Tx settings Variable frame length setting No No Yes Yes
Tx rate settings Traffic format No No Yes Yes

Tx rate
Burst setting

Tx mode settings Tx mode No No Yes Yes
Number of frames
Time (s)

BERT Rx settings Oversize threshold No No Yes Yes
Include error frames in BER test
Timeout period for syncloss
Start pattern comparison from payload of Tx 
frame
Offset
Rx base filter setting

Frame builder Number of frames: 1 No No Yes No
1 This is set automatically when the test layer is L2 or L3-IPv6. You cannot set it.
2 The port settings are displayed.

1.2  List of Features
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Common Settings for RFC2544 Testing
Feature Description Software AQ1300/

AQ1301
Port settings Source Test settings Yes Yes

•	Test	interface
•	Test	layer
Link settings Yes Yes
•	Negotiation
•	Speed
•	Duplex
•	Flow	control
•	MDI
•	Configuration	for	Link	partner	acquisition
Address settings Yes Yes
•	MAC	address
•	VLAN
•	IPv4
•	IPv6
•	L4	(UDP	port	number)

Destination Address settings Yes Yes
•	MAC	address
•	IPv4
•	IPv6

Table settings MAC address table Number of elements: 1 to 16 Yes No
MAC address 1 to MAC address 16

IPv4 address table Number of elements: 1 to 16 Yes No
IPv4 address 1 to IPv4 address 16

IPv6 address (64 bits) table Number of elements: 1 to 16 Yes No
IPv6 address 1 to IPv6 address 16

VLAN table Number of elements: 1 to 16 Yes No
VLAN 1 to VLAN 16
•	User	priority	(CoS)
•	VLAN	ID

Option settings Advanced settings Select setup file after selecting Auto Yes No
Allow to change the test setup

Measurement settings Measurement start condition Yes No
•	Request	ARP/NDP
•		Do	not	start	the	measurement	when	the	

link is down
Measurement stop condition Yes No
•	When	linkdown	is	detected
•	When	an	L2	error	is	detected
•		When	the	test	result	produces	a	fail	
judgment

Operation after measurement stops Yes No
•	Display	the	judge	pass	or	fail	result
•	Save	measurement	results
•	Save	measurement	log
Others1 Yes Yes
•		Subtracting	the	fixed	delay	time	of	the	

opposing
File name settings Results file name File name format Yes Yes

Comment
Specify a directory name
Directory name format
Directory name

Setup file name File name format Yes Yes
Comment

1.2  List of Features
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Feature Description Software AQ1300/
AQ1301

Test result display 
settings

Test result display settings Summary display switching Yes Yes
Throughput test Yes Yes
•	Rate	unit	switching
Latency test Yes Yes
•	Latency	method	switching
Frame loss rate test2 — —
Back to back test2 — —
Packet	jitter	test Yes Yes
•		Display	of	maximum	packet	delay	variation
•		Display	of	minimum	packet	delay	variation
•		Display	of	percentile	packet	delay	variation

1 This feature is supported in firmware version (FW Ver.) R1.08.01.001 and later.
2 Only the item is displayed.

RFC2544 Test Item Settings
Feature Description Software AQ1300/

AQ1301
Test item settings Test information Test name Yes Yes

Customer name
Operator name
Comment

Test items Throughput test Yes Yes
Latency test
Frame loss rate test
Back to back test
Packet	jitter	test

Frame length settings 64 byte Yes Yes
128 byte
256 byte
512 byte
1024 byte
1280 byte
1518 byte
User setting 1 Yes Yes
•	User	definition	1
•	Frame	length
User setting 2 Yes Yes
•	User	definition	2
•	Frame	length
User setting 3 Yes Yes
•	User	definition	3
•	Frame	length

Frame Setting QoS setting Yes Yes
•	Field	specification
•	Value
Payload setting Yes Yes
•	Fill	pattern

Throughput test Throughput test Test duration (in seconds) Yes Yes
Number of trials Yes Yes
Test rate Yes Yes
•	Initial	rate	(as	a	percentage)
•	Minimum	rate	(as	a	percentage)
•	Maximum	rate	(as	a	percentage)
•	Resolution	(as	a	percentage)
•	Use	acceptable	loss
•	Acceptable	loss	(as	a	percentage)

Pass/fail	judgment Pass/fail	judge Yes Yes
Rate (threshold criterion as a percentage)1

1.2  List of Features
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Feature Description Software AQ1300/
AQ1301

Latency test Latency test Test duration (in seconds) Yes Yes
Number of trials Yes Yes
Test rate Yes Yes
•	Measure	using	throughput	result	rate
•	Test	rate	(as	a	percentage)

Pass/fail	judgment Pass/fail	judge Yes Yes
Delay (threshold criterion in µs)1

Frame loss rate 
test

Frame loss rate test Test duration (in seconds) Yes Yes
Number of trials Yes Yes
Test rate Yes Yes
•	Initial	rate	(as	a	percentage)
•	Perform	step-down	measurement
•	Step-down	rate

Pass/fail	judgment Pass/fail	judge Yes Yes
Loss rate (threshold criterion as a 
percentage)1

Back to back test Back to back test Test duration (in seconds) Yes Yes
Number of trials
Resolution (frames)

Pass/fail	judgment Pass/fail	judge Yes Yes
Number of frames (threshold criterion)2

Packet	jitter	test Packet	jitter	test Test duration (in seconds) Yes Yes
Number of trials Yes Yes
Test rate Yes Yes
•	Measure	using	throughput	result	rate
•	Test	rate	(as	a	percentage)
Measurement settings Yes Yes
•	Test	window	size
•	Measurement	resolution
•	Packet	delay	variation	threshold

Pass/fail	judgment Pass/fail	judge Yes Yes
Packet delay variation value (threshold 
criterion in ms)1

1  You can configure these settings on the AQ1300/AQ1301 in the detail setup screen of the RFC2544 setup 
screen. For details, see chapter 8 in the user’s manual, IM AQ1300-01EN.

2 This feature is supported in firmware version (FW Ver.) R1.08.01.001 and later.

1.2  List of Features
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VLAN Test’s Common Settings
This feature is supported in software version R1.09.01.001 and later.
Feature Description Software AQ1300/

AQ1301
Port settings Source Test settings Yes Yes

•	Test	interface
•	Test	layer
•	Add	UDP	to	Tx	frame
Link settings Yes Yes
•	Negotiation
•	Speed
•	Duplex
•	Flow	control
•	MDI
Address settings Yes Yes
•	MAC	address
•	VLAN
•	IPv4
•	IPv6
•	L4	(UDP	port	number)

Destination Address settings Yes Yes
•	MAC	address
•	IPv4
•	IPv6

Table settings MAC address table Number of elements: 1 to 16 Yes No
MAC address 1 to MAC address 16

IPv4 address table Number of elements: 1 to 16 Yes No
IPv4 address 1 to IPv4 address 16

IPv6 address (64 bits) table Number of elements: 1 to 16 Yes No
IPv6 address 1 to IPv6 address 16

Frame length table Number of elements: 1 to 16 Yes No
Frame length 1 to frame length 16

VLAN table Number of elements: 1 to 16 Yes No
VLAN 1 to VLAN 16
•	User	priority	(CoS)
•	VLAN	ID

File name settings Results file name File name format Yes Yes
Comment
Specify a directory name
Directory name format
Directory name

Setup file name File name format Yes Yes
Comment

VLAN Test
Feature Description Software AQ1300/

AQ1301
Tx Settings Interval Test frame transmission interval Yes Yes

Frame length Tx frame length in bytes
Repeat count VLAN ID group transmission repeat count

VLAN ID Tx Setting Not send VLAN ID Yes Yes
VLAN ID list
Input VLAN ID Set from the select list Yes No

Obtain from VLAN ID file Yes Yes
Same as VLAN ID Rx Setting

VLAN ID Rx Setting Use as monitor Yes Yes
Target frame
VLAN ID list
Input VLAN ID Set from the select list Yes No

Obtain from VLAN ID file Yes Yes
Same as VLAN ID Tx Setting

1.2  List of Features
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Ethernet OAM Test’s Common Settings
This feature is supported in software version R1.10.01.001 and later.
Feature Description Software AQ1300/

AQ1301
Port settings Source Test settings Yes Yes

•	Test	interface
•	Test	layer
•	E-OAM
Link settings Yes Yes
•	Negotiation
•	Ability	Notification
•	Speed
•	Duplex
•	Flow	control
•	MDI
•	RF	Automatic
•	Tx	is	continued	while	Link	is	down
•	Clock	Source
•	Configuration	for	Link	partner	acquisition
Address settings Yes Yes
•	MAC	address
•	VLAN
•	MD	Level
Emulate
•	LT	Reply
•	LB	Reply

Destination Address settings Yes Yes
•	MAC	address

Table settings MAC Address table Number of elements: 1 to 16 Yes No
MAC address 1 to MAC address 16

Frame length table Number of elements: 1 to 16 Yes No
Frame length 1 to frame length 16

VLAN table Number of elements: 1 to 16 Yes No
VLAN 1 to VLAN 16
•	User	priority	(CoS)
•	VLAN	ID

MEP ID table Number of elements: 1 to 16 Yes No
MEP ID 1 to MEP ID 16

Tx time table Number of elements: 1 to 16 Yes No
Tx time 1 to Tx time 16

Option settings Advanced settings Allow to change the test setup Yes Yes
Measurement settings Measurement stop condition

•	When	linkdown	is	detected
•	When	an	L2	error	is	detected

File name settings Setup file name File name format Yes Yes
Comment

1.2  List of Features
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Ethernet OAM Test
Feature Description Software AQ1300/

AQ1301
Test item settings LB test Destination MAC address Yes Yes

Interval Yes Yes
Tx Mode Yes Yes
•	Tx	Mode
•	Frames
•	Time	(min)
Frame Length

CC test Domain Yes Yes
•	First	Rx	CCM	apply	to	domain
Mentenance Domain Name Yes Yes
•	Format
•	Form
•	Short	MA	Name
MEP ID Yes Yes
Tx Yes Yes
•	Enable
•	Destination	MAC	address
•	Interval
•	Auto	Tx	RDI
•	Tx	START	Condition
Rx Yes Yes
•	Enable
•	Target	MEP	ID

1.2  List of Features



1-14 IM AQ1300-61EN

Common Settings for Y.1564 Testing
Feature Description Software AQ1300/

AQ1301
Port settings Source Test settings Yes Yes

•	Test	interface
•	Test	layer
Link settings Yes Yes
•	Negotiation
•	Speed
•	Duplex
•	Flow	control
•	MDI
•	Direction
•	Asymmetric	Test
Address settings Yes Yes
•	MAC	address
•	VLAN
•	IPv4
•	IPv6
•	L4	(UDP	port	number)
Emulation Settings Yes Yes
•	IPv4
•	IPv6

Destination Address settings Yes Yes
•	MAC	address
•	IPv4
•	IPv6
•	UDP

Table settings MAC address table Number of elements: 1 to 16 Yes No
MAC address 1 to MAC address 16

IPv4 address table Number of elements: 1 to 16 Yes No
IPv4 address 1 to IPv4 address 16

IPv6 address (64 bits) table Number of elements: 1 to 16 Yes No
IPv6 address 1 to IPv6 address 16

VLAN table Number of elements: 1 to 16 Yes No
VLAN 1 to VLAN 16
•	User	priority	(CoS)
•	VLAN	ID

Option settings Advanced settings Select setup file after selecting Y.1564 Yes No
Enable to edit with MFT
Allow to change the test setup

Measurement settings Enable to edit with MFT Yes No
Measurement start condition
•	Request	ARP/NDP
•		Do	not	start	the	measurement	when	the	

link is down
Measurement stop condition Yes No
•	When	linkdown	is	detected
•	When	an	L2	error	is	detected
•	When	an	L3	error	is	detected
•		When	the	test	result	produces	a	fail	
judgment

Operation after measurement stops Yes No
•	Display	the	judge	pass	or	fail	result
•	Save	measurement	results
•	Save	measurement	log
Others1 Yes Yes
•		Subtract	the	fixed	latency	from	the	result

1.2  List of Features
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Feature Description Software AQ1300/
AQ1301

File name settings Results file name File name format Yes Yes
Comment
Specify a directory name
Directory name format
Directory name

Setup file name File name format Yes Yes
Comment

Y.1564 Test Item Settings
Feature Description Software AQ1300/

AQ1301
Test item settings Test information Test name Yes Yes

Customer name
Operator name
Comment

Test items Configuration Test Yes Yes
•	Test	Duration
•	CIR	Test
		Step	count,	Min.	Rate	(CIR×n[%])
•	EIR	Test
•	Policing	Test
•	CBS	Test
•	EBS	Test
Performance Test
•	Test	Duration

Unit Setup Unit Setup Yes Yes
•	Test	Rate	Unit
Frame Delay Valiation Measurement Settings
•	FDV	Measurement
•	FD	Reference

Service Setup
(Service 1 to Service 8)

Enable Yes Yes
Service Type
•	Codec	Type
Payload Pattern
Frame Length
•	MTU
•	User
•	EMIX
Color
•	Green
•	Yellow
SLA
•	CIR	(Committed	Information	Rate)
•	FLR	(Frame	Loss	Rate)
•	EIR	(Excess	Information	Rate)
•	CBS	(Committed	Burst	Size)
•	EBS	(Excess	Burst	Size)
•	FD	(Frame	Delay)
•	FDV	(Frame	Delay	Variation)
•	FDV	(%ile)1

Source address settings Yes Yes
Destination address settings

1 %ile : percentile

1.2  List of Features
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1.3 Features

This section will explain the main features that you can only set and operate from the setup software.

Making Items Editable from the AQ1300/AQ1301
Set the items that you want to edit from the AQ1300/AQ1301 to ON. All items that are set to OFF 
cannot be edited from the AQ1300/AQ1301.
For details, see section 3.2.

Table Settings
Create the following tables for use on the AQ1300/AQ1301.
•	 MAC	address	tables
•	 IPv4	address	tables
•	 IPv6	address	(64	bits)	tables
•	 Frame	length	tables
•	 VLAN	tables
•	 MEP	ID	tables
•	 Tx	rate	(%)	tables
•	 Frames	tables
•	 Tx	time	tables
•	 QoS	tables
For details, see section 3.3.

Select Test Item Settings
Specify the test items that are displayed on the AQ1300/AQ1301 “Select Test Item” screen when Auto, 
Auto(Remote), and RFC2544 tests are performed. You can register up to 8 test items in one setup file 
(.sd).
For details, see section 3.5.

Pass/Fail Judgment Settings
Set	the	pass/fail	judgment	settings	for	when	Auto,	Auto(Remote),	and	RFC2544	tests	are	performed.	
The	AQ1300/AQ1301	only	indicates	the	pass/fail	judgment;	you	cannot	change	these	settings	from	the	
AQ1300/AQ1301.
For details, see section 3.6.

Frame builder
Configure the Tx frames for when Manual tests are performed.
For details, see section 3.7.

VLAN Test
(Software versions R1.09.01.001 and later)
You can set the VLAN ID information (VLAN ID list) by specifying IDs from a select list.
In the list of VLAN test results, you can move to a specific VLAN ID position.
For details, see section 3.9.

E-OAM Test
Ethernet Operation, Administration and Maintenance (hereafter referred to as E-OAM) tests can be 
performed in compliance with the ITU-T Y.1731 Recommendation and IEEE802.1ag Standard.
This is supported in firmware version R1.10.01.001 and later.
•	 CC	(continuity	check)	test:	Connection	check	between	network	devices
•	 LB	(loop	back)	test:	Response	check	between	network	devices
•	 LT	(link	trace):	Link	check	between	network	devices
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Y.1564 Test
An automated test function in conformity with ITU-T Y.1564, the standard benchmarking methodology 
for a performance examination of Ethernet service and network systems.
•	 IR	step	test
 Measurement of information rate (IR), frame loss (FL), frame transfer delay (FTD), frame delay 

variation (FDV)
•	 Burst	size	test
 Measurement of frame loss (FL), frame transfer delay (FTD), frame delay variation (FDV)
•	 Service	performance	test
 Measurement of information rate (IR), frame loss (FL), frame transfer delay (FTD), Frame delay 

variation (FDV), availability 
(AVAIL)

Registering Setup Files to the Select File Display
Register the setup files that are displayed in the setup file list on the AQ1300/AQ1301 “Select Setup 
File” screen when Auto, Auto(Remote), and RFC2544 tests are performed. You can register up to 48 
setup files to the setup file list (4 pages with 12 files per page).
For details, see section 4.3.

Exporting Statistical Results to .CSV Files
You can export statistical results files (.mr) that you downloaded from the AQ1300/AQ1301 to .CSV 
files.
For details, see section 4.5.

FTP Client
Use FTP over an Ethernet to transfer files (upload and download) between the AQ1300/AQ1301 and 
an FTP client.
For details, see section 4.6.

Simple Test Setting Auto Wizard
(Software versions R1.6.1.1 and later)
Follow the instructions in the wizard to create setup data for Auto and Auto(Remote) tests.
For details, see section 4.7.

Select File Display Data Creation Wizard
(Software versions R1.09.01.001 and later)
Follow the instructions in the wizard to register the setup file list that is displayed in the setup file list on 
the AQ1300/AQ1301 “Select Setup File” screen when Auto, Auto(Remote), RFC2544, and Y.1564 tests 
are performed.
In	this	process,	you	can	also	register	the	setup	file	list	to	a	project.	In	addition,	package	files	can	be	
created.
For details, see section 4.8.

Managing Projects
(Software versions R1.09.01.001 and later)
A pair consisting of a setup file (.sd) and setup file list (disManage.dmf) or a package file (.dmfz) that 
contains	the	pair	of	files	is	managed	as	a	project	on	the	PC.
You can specify an AQ1300/AQ1301 connected via USB or LAN and use the Trans. Setup File and 
Get Result File buttons to automatically transfer these files to their appropriate folders.
Result files (.mr) are saved in a folder identified by the AQ1300/AQ1301 host name or serial number in 
the	project.
For details, see section 4.9.

1.3  Features
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PDF Export of Statistical Results
(RFC2544 test/Y.1564 test; software versions R1.6.1.1 and later)
You can export statistical results files (.mr) that you downloaded from the AQ1300/AQ1301 to PDF 
format.
For details, see section 4.10.

Graph Image Export of Statistical Results
(RFC2544 test; software versions R1.6.1.1 and later)
You can export graphs of the statistical results as image files.
An image file is exported for each test item that is displayed in a statistical results file (.mr) when it is 
opened. The statistical results file must be downloaded from the AQ1300/AQ1301.
For details, see section 4.11.

1.3  Features
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1.4 Screen Explanation

The setup software screen contains a menu bar, a control view, and an MDI screen.

 

Control view 
Use to select the items that 
you want to set. 

Menu bar 

MDI screen 
Displays the screens for the items that you select from 
the control view. 

Control View

 (Gray) An item (folder) that you cannot set

 (Gray) An item that you can set

 (Blue) The selected item
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The frame builder, FTP client, and Select File Display appear in their own independent screens.

 

Frame Builder Screen 

1.4  Screen Explanation
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2.1 Starting and Closing the Software

Procedure
Starting the Software

1. Click Start , All Programs , yokogawa, AQ1300 , and then cl ick AQ1300/AQ1301 
SetupSoftware.
The setup software starts, and the Measurement dialog box appears. You can also start the software by 
double-clicking its shortcut icon on the desktop.

    Control view 

Screen display area

2. From the following items, click an item that you want to set.
Basic Test
•	 Auto
•	 Auto(Remote)
•	 Manual
Option Test
•	 RFC2544
•	 VLAN
•	 Ethernet	OAM
•	 Y.1564

 To use a wizard to configure the settings, click Simple Test Setting Auto or Simple List File 
Setting.
The dialog box closes, and the setup screen for the test that you selected is displayed.

 Display example: Auto test setup screen

    

Note
You cannot proceed until you select a test and close the Measurement dialog box.

Chapter 2 Starting and Closing the Software
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Closing the Software
 On the File menu, click Exit.

The setup software closes.

    

Explanation
The Setup Software test items are as follows:

Basic	Test
•	 Auto
•	 Auto(Remote)
•	 Manual

Option Test
•	 RFC2544
•	 VLAN
•	 Ethenet	OAM
•	 Y.1564

When you start the setup software, select a test. If you do not, you can not proceed.
You can use the Edit menu to change the test. For details, see section 2.2.

2.1  Starting and Closing the Software
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2.2 Changing the Test

Procedure
1. On the Edit menu, click Switch Test and then Auto, Auto(Remote), Manual, RFC2544, or 

VLAN to select the test.

    

2. Follow the appropriate setup procedure to set the selected test.
For information about the items that you can specify, see section 1.2.

Explanation
The test items are as follows:

Basic	Test
•	 Auto
•	 Auto(Remote)
•	 Manual

Option Test
•	 RFC2544
•	 VLAN
•	 Ethenet	OAM
•	 Y.1564

For details on each test, see the user’s manual, IM AQ1300-01EN.

Note
•	 If	you	use	“Create	a	new	Setup	File”	(see	sections	2.1	and	4.1)	to	select	a	test,	all	the	current	settings	are	

initialized.
•	 When	you	change	the	test	type	to	RFC2544	or	change	from	RFC2544	to	another	test	type,	all	the	settings	

are initialized.
•	 When	you	change	the	test	type	to	VLAN	or	change	from	VLAN	to	another	test	type,	all	the	settings	are	

initialized.
•	 If	you	switch	to	a	different	test,	all	but	the	following	settings	are	initialized.
 Table, file name, statistics log settings, and statistics display items.
•	 When	you	change	the	test	type	to	Y.1564	or	change	from	Y.1564	to	another	test	type,	all	the	settings	are	

initialized.
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3.1	 Basic	Operations

This section explains how to use the setup software to set items. You will mainly use the following 
three interface elements.

List	Boxes
You can use list boxes to select the item that you want to set.

 

Use the list box to select the item that 
you want to set.

Button Description
OK Applies the settings and closes the screen.
Cancel Closes the screen without applying the settings.
Apply Applies the settings without closing the screen.

Spin	Boxes
You can use spin boxes to change values.

 

Decreases the number

Increases the number

Chapter 3 Setup Procedure
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Text	Boxes
You can use text boxes to enter values or strings.

 

Enter a value in the text box.

Enter a string in the text box.

If you enter a value that is out of range, the setting will take a value within the range that is closest to 
the value you specified.
When you enter a string, any characters outside of the maximum number of characters are not 
displayed.

3.1		Basic	Operations
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3.2 Making Items Editable from the AQ1300/AQ1301

Example of Setting the Source in the Port Settings
On the control view, click Setting, Common Setting, Port Setting, and then click Source to display 
the following screen.

 

Enable to edit with MFT (ON, OFF)
Set whether or not to make this item 
editable from the AQ1300/AQ1301.

Making Items Editable from the AQ1300/AQ1301
ON:  Items that are set to ON can be edited from the AQ1300/AQ1301.
OFF: Items that are set to OFF cannot be edited from the AQ1300/AQ1301.

Note
•	 You	can	only	set	“Enable	to	edit	with	MFT”	from	the	setup	software.	You	cannot	change	this	setting	from	

the AQ1300/AQ1301.
•	 Set	this	to	OFF	for	any	settings	that	you	do	not	want	to	be	editable	from	the	AQ1300/AQ1301.
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3.3 Setting Tables

On the control view, click Setting, Common Setting, and then click Setup value table to display the 
following screen.

 

Number of elements to register 
in the table (0–16)

Table settings 

Number of Table Elements to Register
 Set the number of table elements that you want to register (0 to 16). If you specify 0, you cannot 

register any elements to the table.

Table Name Elements Other Settings
Table of MAC addresses 1 to 16
Table of IPv4 addresses 1 to 16
Table of IPv6 addresses (64 bits) 1 to 16
Table of length 1 to 16
Table of VLAN settings 1 to 16 User priority (CoS) and VLAN ID
Table of MEP ID 1 to 16
Table of Tx rates (%) 1 to 16
Table of frames 1 to 16
Table of time 1 to 16
Table of QoS settings 1 to 16 CH1 to CH4, whether to use or not, QoS, frame length, and 

Tx rate

Note
You can only set tables from the setup software. You cannot set them from the AQ1300/AQ1301.
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3.4 Setting Statistics Display Items for Auto, 
Auto(Remote), and Manual Tests

Test Result Indications
On the control view, click Setting, Common Setting, Setup display item, and then click Test Result 
to display the following screen.

 

Test Result Setting Setup Item
Rate unit switch %, fps, bps
Traffic switch Maximum, Average
QoS switch Maximum, Average, Current
Summary switch Summary, Address



3-6 IM AQ1300-61EN

Tx/Rx Comparison Display
1. On the control view, click Setting, Common Setting, Setup display item, and then click Tx/Rx 

Comparison Display to display the Tx/Rx Comparison Display screen.

2. Select the position where you want to insert a new item.

3. Select the item that you want to insert.

 

Displays the previous 
page

Displays the next page

Select the item to insert.

Adds the selected item

Clears all items

Moves the selected item up one position

Moves the selected item down one position

Select the position where you want to insert 
a new item.

4. Click Add to insert the selected item.

5. Select the check boxes on the lines that you want to display.

   

The selected item is inserted.

Select the check boxes for the lines that you want to display.
Lines with cleared check boxes are blank.

Note
•	 You	can	register	up	to	2	pages	of	items,	19	items	on	each	page.
•	 The	check	boxes	of	added	items	are	selected	automatically.
•	 When	you	add	an	item,	the	cursor	moves	to	the	item	below	the	added	item.

3.4  Setting Statistics Display Items for Auto, Auto(Remote), and Manual Tests
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Custom Display
1. On the control view, click Setting, Common Setting, Setup display item, and then click 

Custom Display to display the Custom Display screen.

2. Select the position where you want to insert a new item.

3. Select the group that contains the item that you want to insert. The selected group’s items are 
displayed.

4. Select the item that you want to insert.

  

Clears all items
Adds the selected item

Moves the selected item up one position
Moves the selected item down one position

Displays the next page

Select the position where you want to 
insert a new item.

Select the item to insert.

Select the group to insert.

Displays the previous page

5. Click Add to insert the selected item.

6. Select the check boxes on the lines that you want to display.

   

The selected group’s item is inserted.

Select the check boxes for the lines that you want to display.
Lines with cleared check boxes are blank.

Note
•	 You	can	register	up	to	2	pages	of	items,	19	items	on	each	page.
•	 The	check	boxes	of	added	items	are	selected	automatically.
•	 When	you	add	an	item,	the	cursor	moves	to	the	item	below	the	added	item.

3.4  Setting Statistics Display Items for Auto, Auto(Remote), and Manual Tests
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Detailed Statistics Display
1. On the control view, click Setting, Common Setting, Setup display item, and then click Detail 

Display to display the Detail Display screen.

2. Use the Next Page and Prev. Page buttons to select the page where you want to insert a 
group.

3. Select the group that you want to insert.

   

Adds the selected group

Select the group to insert.

Displays the next pageDisplays the previous 
page

Deletes the selected group

4. Click Add to insert the selected group’s page.

   

The selected group is inserted.

The inserted group’s page is added.

Note
•	 Each	group	of	detailed	statistics	is	displayed	on	a	single	page.
•	 You	can	register	up	to	32	pages.

3.4  Setting Statistics Display Items for Auto, Auto(Remote), and Manual Tests
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3.5 Setting Selected Test Items for Auto, 
Auto(Remote), and RFC2544 Tests

Auto Test
On the control view, click Setting, Auto, and then click Setup Select Test Item to display the following 
screen.

 

Adds the selected test item
Deletes the selected test item
Moves the selected test item 
up one position
Moves the selected test item 
down one position

Enter the test 
item’s name.

Change the test items.
(Traffic, Loopback, QoS, Ping, Bert)
Double-click to display a list.
From this list, you can change to another test item.

Select a test item to add.
(Traffic, Loopback, QoS, 
Ping, Bert)

 

The added test itemThe added test item is 
displayed in the Control 
View.

Number of Test Items
You can register up to 8 test items in one setup file (.sd).

Test Item Names
Double-clicking a Test item Name cell causes a cursor to appear, and you can enter the name.
Names can be up to 30 characters.
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Auto(Remote) Test
On the control view, click Setting, Auto(Remote), and then click Setup Select Test Item to display 
the following screen.

 

Enter the test 
item’s name.

Change the test items.
(Source: Traffic, QoS, Ping
 Destination: Traffic, QoS, Ping, Loopback)
Double-click to display a list.
From this list, you can change to another test item.

Change the test direction.
(M => S, M <= S, M <=> S, M <=> LOOP )
Double-click to display a list.
From this list, you can change to another test direction.

Adds the selected test item
Deletes the selected test item
Moves the selected test item 
up one position
Moves the selected test item 
down one position

Select a test item to add.
(Traffic, QoS, Ping)

 

The added test itemThe added test item is 
displayed in the Control 
View.

Number of Test Items
You can register up to 8 test items in one setup file (.sd).

Test Item Names
Double-clicking a Test item Name cell causes a cursor to appear, and you can enter the name.
Names can be up to 30 characters.

Note
•	 Set	the	test	items	that	you	want	to	display	on	the	AQ1300/AQ1301	Select	Test	Item	screen.
•	 You	can	only	set	selected	test	items	from	the	setup	software.	You	cannot	set	them	from	the	AQ1300/

AQ1301.

3.5  Setting Selected Test Items for Auto, Auto(Remote), and RFC2544 Tests
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RFC2544 Test
On the control view, click Setting, RFC2544, and then Common Setting to display the following 
screen.

 
Select test items.
 ON: Selected
 OFF: Not selected

Test frame lengths
 ON: Selected
 OFF: Not selected

3.5  Setting Selected Test Items for Auto, Auto(Remote), and RFC2544 Tests
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3.6 Setting Pass/Fail Judgment Conditions for 
Auto, Auto(Remote), and RFC2544 Tests

Auto and Auto(Remote) Tests
On the control view, click Setting, Auto (or Auto(Remote)), Setup Select Test Item, and then click 
Test Item1 to display the following screen.

 

Set the pass/fail judgment settings 
(ON, OFF).
Set this to ON for items that you want 
to perform pass/fail judgment for.

Example of Test Item1 (Traffic) for Auto Test

Example of Test Item1 (Traffic <=> Traffic) for Auto(Remote) Test

Set the source pass/fail judgment setting 
(ON, OFF).
Set this to ON for items that you want to 
perform pass/fail judgment for.

Select	other	test	items	when	you	want	to	set	their	pass/fail	judgment	conditions.

Note
You	can	only	set	pass/fail	judgment	conditions	for	Auto	and	Auto(Remote)	tests	from	the	setup	software.	You	
cannot set them from the AQ1300/AQ1301.
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Default Test Items
Auto Test

Source
Test item 1 Traffic
Test item 2 Loopback
Test item 3 QoS
Test item 4 Ping
Test item 5 BERT

Auto(Remote) Test
Source Destination Test direction

Test item 1 Traffic Traffic Master <=> slave
Test item 2 Traffic Loopback Master <=> Loop
Test item 3 QoS QoS Master <=> slave
Test item 4 QoS Loopback Master <=> Loop
Test item 5 Ping Ping Master <=> slave

Pass/Fail Judgment Settings
Traffic
Link, Tx, Rx L1 error: Link down detection

L1 error: LF or RF reception
L2 error: Error frame reception
L3 error: Payload error detection
L3 error: Sequence error detection
Incorrect number of bytes
Incorrect number of frames
Maximum Rx rate Judgment method, range unit, upper limit (%), and lower limit (%)
Average Rx rate Judgment method, range unit, upper limit (%), and lower limit (%)
Maximum latency time Upper limit (ms)

Loopback
Loopback	does	not	have	any	pass/fail	judgment	settings.

QoS
Link, Tx, Rx L1 error: Link down detection

L1 error: LF or RF reception
L2 error: Error frame reception
L3 error: Payload error detection
Incorrect number of bytes
Incorrect number of frames
Maximum Rx rate Judgment method, range unit, upper limit (%), and lower limit (%)
Average Rx rate Judgment method, range unit, upper limit (%), and lower limit (%)
Maximum latency time Upper limit (ms)

QoS channel settings CH1 to CH4
L3 error: Payload error detection
L3 error: Sequence error detection
Incorrect number of bytes
Incorrect number of frames
Maximum Rx rate Judgment method, range unit, upper limit (%), and lower limit (%)
Average Rx rate Judgment method, range unit, upper limit (%), and lower limit (%)
Maximum latency time Upper limit (ms)

Ping
Frame loss detection
Maximum response time

BERT
Bit error detection
No target bytes

3.6  Setting Pass/Fail Judgment Conditions for Auto, Auto(Remote), and RFC2544 Tests
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RFC2544 Test
Example of an RFC2544 Throughput Test
On the control view, click Setting, RFC2544, Common Setting, and then Throughput to display the 
following screen.

 

Set the pass/fail judgment 
settings (ON, OFF).
Set items that you want to 
perform pass/fail judgment 
on to ON.

3.6  Setting Pass/Fail Judgment Conditions for Auto, Auto(Remote), and RFC2544 Tests
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3.7	 Using	Frame	Builder	for	Manual	Tests

1. On the control view, click Setting, Manual, Setup Select Test Item, and then click Traffic (QoS 
or Bert) to display the following screen.

  

Traffic Example

•  Frame structure

•  Frame length
Displays the Tx frame settings

Starts Frame Builder

2. Click Frame	Builder to display the following screen.

Applies the settings and closes 
the screen

Frame Pattern display 
The frame pattern data for the 
selected field is displayed in blue.

Discards the settings and closes 
the screen
Initializes the settings
Saves the settings to a file (.frd)
Loads settings from a file (.frd)

Displays the headers of 
the selected field items

Enabled when “Refer to Source Address” 
is not selected.

Field items 
Displays the items for the selected 
field.

Field buttons
Press to select the field items that 
you want to display.

Frame structure selection (Format List, 
Protocol Stack, Custom),
Frame Length setting (48–9999 bytes), 
Real Frame Length display, and 
automatic frame length calculation

Select this check box to refer to the source address 
for the VLAN settings.
VLAN is enabled when Frame Structure is set to Format 
List or Protocol Stack.
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3. Select the Frame Structure. The screen updates to match the frame structure that you select.

Format List

Select the frame format.

Protocol Stack Custom

Select the protocol stack. Perform custom settings.
Use the frame pattern’s payload to 
set these settings.

4. Configure the frame.

5. Set the frame length. Set VLAN if necessary.

6. Configure the field settings if necessary.

   

IPv4+UDP Example
MAC Field

Type Field

IPv4 Field

UDP Field

Payload Field

FCS Field

3.7		Using	Frame	Builder	for	Manual	Tests
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7. Click OK to fix the frame and close Frame Builder.

Traffic Example

The contents of the Tx frame 
change to what you specified 
using Frame Builder.

•  Frame structure

•  Frame length

Note
•	 If	the	frame	structure	that	is	displayed	under	Tx	Frame	Setting	is	not	one	of	the	following	frame	structures,	

the frame structure is indicated as “Unknown” on the AQ1300/AQ1301.
MAC+Type+Payload+FCS
MAC+Type+VLAN+Payload+FCS
MAC+Type+IPv4+Payload+FCS
MAC+Type+IPv4+UDP+Payload+FCS
MAC+Type+VLAN+IPv4+Payload+FCS
MAC+Type+VLAN+IPv4+UDP+Payload+FCS
MAC+Type+IPv6+Payload+FCS
MAC+Type+IPv6+UDP+Payload+FCS
MAC+Type+VLAN+IPv6+Payload+FCS
MAC+Type+VLAN+IPv6+UDP+Payload+FCS

•	 If	you	start	measurement	or	transmission	while	the	AQ1300/AQ1301	frame	structure	is	“Unknown,”	frames	
whose structure was defined in Frame Builder are transmitted.

3.7		Using	Frame	Builder	for	Manual	Tests
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Frame	Builder	Settings
Item Description
Format list, protocol stack, 
and custom

Sets the frame structure.

Format list You can select the format from one of the following choices.
(User), Pause, ARP, IPv4, IPv4+UDP, IPv4+TCP, IPv4+IGMP, IPv4+ICMP, IPv6, IPv6+UDP, 
IPv6+TCP,	IPv6+IGMP,	IPv6+ICMP,	IPv6+ICMPv6,	IPX,	E-OAM(ITU-T),	E-OAM(IEEE),	or	ECP

Protocol stack You can set L2, L3, and L4 separately. The items that you can select for the upper layers differ 
depending on the items that you select for the lower layers.

Options
L2 Dix, IEEE802.3, Pause, ARP, or ECP
L3 The item selected for L2

Dix
IEEE802.3
Pause
ARP
ECP

(User),	IPv4,	IPv6,	IPX,	E-OAM(ITU-T),	or	E-OAM(IEEE)
(User),	IPv4,	IPv6,	IPX,	E-OAM(ITU-T),	or	E-OAM(IEEE)
None
None
None

L4 The item selected for L3
(User)
IPv4
IPv6
IPX
E-OAM(ITU-T)
E-OAM(IEEE)

None
(User), UDP, TCP, IGMP, or ICMP
(User), UDP, TCP, IGMP, ICMP, or ICMPv6
None
None
None

Insert the LLC/SNAP header ON or OFF
Enabled when L2 is selected for the Protocol Stack, and “IEEE802.3” 
is selected for L2.

Custom You can select whether to specify a MAC address or not. All other fields are used as user data.
Specify MAC address ON or OFF

OpCode Select the “E-OAM(ITU-T)” or “E-OAM(IEEE)” OpCode. This is enabled when you set Frame 
Structure to “Format List” or “Protocol Stack” and set Format to “E-OAM(ITU-T)” or “E-OAM(IEEE).”
E-OAM(ITU-T) (User), CCM, LBM, LBR, LTM, LTR, AIS, LCK, TST, APS, MCC, LMM, 

LMR,	1DM,	DMM,	DMR,	EXM,	EXR,	VSM,	or	VSR
E-OAM(IEEE) (User), CCM, LBM, LBR, LTM, or LTR

Tag settings You can configure tag settings when you set Frame Structure to “Format List” or “Protocol Stack.” 
You can set whether to use the source address setting for the VLAN setting or not. You can set this 
separately for the L2 and L3 tags.
There are the following limitations when you set the L2 and L3 tags separately.
•	When	Format	is	Pause,	ARP,	or	ECP,	you	cannot	set	the	L3	tag.
•	When	Format	is	ECP,	the	MAC	in	MAC	EoE	is	inserted	automatically.
•	When	MAC	in	MAC	is	selected,	you	cannot	select	EoMPLS.
Refer to source address ON or OFF Select this check box to refer to the source address for 

the VLAN settings.
L2 Insert MAC in MAC

IEEE802.1ah or EoE
Insert B-Tag
Insert EoEVLAN Tag
Insert VLAN Tag
Number of stacks

ON or OFF
ON
ON or OFF
ON or OFF
ON or OFF
1 to 4

Enabled when Insert MAC in MAC is selected
Enabled when IEEE802.1ah is selected
Enabled when EoE is selected

Enabled when Insert VLAN Tag is selected
L3 L3 Tag None, MPLS, or EoMPLS

Number of stacks 1 to 4 Enabled when MPLS or EoMPLS is selected for L3 Tag
Frame length Sets the frame length, including the FCS.

48 to 9999 bytes
When “Refer to Source Address” is selected, set the frame length to a value that does not include 
tags.
When “Refer to Source Address” is not selected and the L2 or L3 tag is set, set the frame length to a 
value that includes the tags.
The color of the Frame Length box changes according to the frame length.
•	  White: Normal status.
•	  Red: A portion of the specified protocol header cannot be transmitted.
•	  Yellow: A portion of the specified payload cannot be transmitted.
Auto Press this button to automatically calculate the minimum frame length 

that will make the frame length status normal (white).

3.7		Using	Frame	Builder	for	Manual	Tests
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Item Description
Field buttons Press to display the selected field’s setup screen.
Header reference button Press to display the selected field’s header. Depending on the selected field, this button may be 

unavailable.
Field items Displays the settings for the field that you selected with the field buttons.

The settings differ depending on the field that you select.
Frame pattern Displays the frame pattern. The frame pattern data for the field that you selected with the field 

buttons is displayed in blue.

3.7		Using	Frame	Builder	for	Manual	Tests
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3.8 RFC2544 Test Result Display

1. On the control view, click Setting, Common Setting, and then Result Display Setting to 
display the following screen.

    

Setting Setup Item
Summary display switching Summary, Address
Rate unit %, fps, bps
Latency method switching S&F Latency, CT Latency
Display of maximum packet delay variation OFF or ON
Display of minimum packet delay variation OFF or ON
Display of percentile packet delay variation OFF or ON
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3.9  Configuring the VLAN Test

Tx Settings
On the control view, click Setting, VLAN, and Tx Setting. The following screen appears.

 

Setting Setup Items
Interval 1ms, 10ms, 100ms, 1s
Frame Length •	L2	and	L3-IPv4

VLAN 1 stack: 64 (68) to 9999 (9999)
VLAN 2 stacks: 64 (72) to 9999 (9999)

•	L3-IPv6
VLAN 1 stack: 74 (78) to 9999 (9999)
VLAN 2 stacks: 74 (82) to 9999 (9999)

Repeat Count 1 to 15
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VLAN ID Tx Setting
On the control view, click Setting, VLAN, and VLAN ID Tx Setting. The following screen appears.

  

VLAN ID list

Item Description
Not Send VLAN ID Select this check box to not send VLAN IDs.
VLAN ID list The IDs specified by Input VLAN ID are listed.
Filter By Input ID •	Selected:		Only	the	IDs	that	have	been	set	are	displayed.

•	Cleared:		 IDs	from	0	to	4095	are	displayed	with	the	following	colors.
•	Black:		 An	ID	that	has	been	set
•	Blue:		 An	ID	that	has	not	been	set

 

Input VLAN ID
ID Single Specify the ID to add or delete in the Begin box.

Range Specify the range of IDs to add or delete in the Begin and End boxes.
If you enter a number in the Step box, IDs will be entered in the specified steps 
from Begin to End.

Add Adds the ID specified by Single or IDs specified by Range to the VLAN ID list
Del Deletes the ID specified by Single or IDs specified by Range from the VLAN ID 

list
Set from the select list Select this check box to display a select list on the right side of the window.

See “Setting IDs from the Select List” (next section).
From VLAN ID File

Read Reads IDs from a VLAN ID definition file (text file in CSV format) and displays 
them in the VLAN ID list

Same as VLAN ID Rx Setting
Set Applies the IDs specified in VLAN ID Rx Setting to the VLAN ID Tx Setting

3.9  Configuring the VLAN Test
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Setting IDs from the Select List
Selecting the “Set from the select list” check box displays a select list on the right side of the 
window.
Select or clear the ID check boxes in the select list to apply the changes in the VLAN ID list.

  

Select listVLAN ID list

Item Description
Select List IDs from 0 to 4095 are listed.

Check boxes corresponding to the IDs already set in the VLAN ID list are selected.
Select Adds the IDs specified in the select list to the VLAN ID list
Clear Clears the IDs specified in the select list from the VLAN ID list
Select All Adds all IDs to the VLAN ID list
Clear All Clears all IDs from the VLAN ID list

Selecting or Clearing IDs

1.  In the select list, click the cell of the ID that you want to select or clear.
Hold down Shift and click to select multiple cells; drag to select a range of cells.
The cells that you clicked are highlighted. You will be able to select or clear the IDs in these cells.

2.  Click Select or Clear.
Check boxes in the select list
•		 Check	boxes	that	correspond	to	IDs	that	are	added	to	the	VLAN	ID	list	will	be	selected.
•		 Check	boxes	that	correspond	to	IDs	that	are	deleted	from	the	VLAN	ID	list	will	be	cleared.

Note
The feature that enables you to specify IDs in the select list to set to the VLAN ID list is only available on the 
Setup Software. It is not available on the AQ1300/AQ1301.

3.9  Configuring the VLAN Test
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VLAN ID Rx Setting
On the control view, click Setting, VLAN, and VLAN ID Rx Setting. The following screen appears.

  

VLAN ID list

Item Description
Use as Monitor Select this check box to use this software as a monitor.

When	used	as	a	monitor,	judgment	of	ID	errors,	unreceived	IDs,	and	pass/fail	are	
not performed.

Target Frame •	All:		 All	frames	are	received.
•	Only	AQ130x:			Only	the	test	frames	that	the	AQ1300/AQ1301	transmits	are	

received.
VLAN ID list The IDs specified by Input VLAN ID are listed.
Filter By Input ID •	Selected:		Only	the	IDs	that	have	been	set	are	displayed.

•	Cleared:		 IDs	from	0	to	4095	are	displayed	with	the	following	colors.
•	Black:		 An	ID	that	has	been	set
•	Blue:		 An	ID	that	has	not	been	set

 

Input VLAN ID
ID Single Specify the ID to add or delete in the Begin box.

Range Specify the range of IDs to add or delete in the Begin and End boxes.
If you enter a number in the Step box, IDs will be entered in the specified steps 
from Begin to End.

Add Adds the ID specified by Single or IDs specified by Range to the VLAN ID list
Del Deletes the ID specified by Single or IDs specified by Range from the VLAN ID list
Set from the select list Select this check box to display a select list on the right side of the window.

This feature is the same as that of VLAN ID Tx Setting.
See “Setting IDs from the Select List” (previous section).

From VLAN ID File
Read Reads IDs from a VLAN ID definition file (text file in CSV format) and displays 

them in the VLAN ID list
Same as VLAN ID Tx Setting

Set Applies the IDs specified in VLAN ID Tx Setting to the VLAN ID Rx Setting

3.9  Configuring the VLAN Test
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Error Message
An error message may appear when VLAN IDs are read from a VLAN ID definition file. This section 
describes the error message and how to respond to them.

Message Corrective Action
Illegal file format. Check that the specified VLAN ID definition file is in the correct 

format.

3.9  Configuring the VLAN Test
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3.10 Configuring the Ethenet OAM Test

LB	Test	Setting
On the control view, click Setting, EthernetOAM, and Common Setting. and LB	test. The following 
screen appears.

 

Item Description
Destination MAC address Set the target MEP’s MAC address.
Interval 1ms, 10ms, 100ms, 1s
Tx Mode Continue, Frames, Time

•	Frames
  Number of frames: 1 to 4294967295
•	Time
  Time (min): 1 to 1440

Frame Length No VLAN stacks: 64 (64)-9999 (9999)
VLAN 1 stack: 64 (68) to 9999 (9999)
VLAN 2 stacks: 64 (72) to 9999 (9999)

CC Test Setting
On the control view, click Setting, EthernetOAM, and Common Setting. and CC test. The following 
screen appears.
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Item Description
Domain

First Rx CCM apply to domain OFF, ON
Maintenance Domain Name Manually set the maintenance domain name.

Format Not use, String, DNS, MAC+ID, User
Format value 0 to 255, Can be set when the Format is set to User
Form Text, Binary

Short MA Name Manually set the short maintenance group name. 
Format String, Integer, VLAN ID, ICC-Base string, User
Format value 0 to 255, Can be set when the Format is set to User
Form Text, Binary
Short MA name Enter the short maintenance group name.
MEG ID Enter the MEG ID.

MEP ID Enter the MEP ID.
Tx

Enable ON, OFF
Destination MAC

Address Type Unicast, Multicast
MAC Address Set the target MEP’s MAC address. Can be set when the Address Type is set to 

Unicast.
Interval 100ms, 1s, 10s, 60s
Auto Tx RDI ON, OFF
Tx START Condition

Condition Test start, First Rx CCM
Wait time 0 to 999 s, Can be set when the Condition is set to Test start.

Rx
Enable ON, OFF
Target MEP ID

Target Manual,	First	RX	CCM
MEP ID Enter the MEP ID. Can be set when the Target is set to Manual.

3.10  Configuring the Ethernet OAM Test
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3.11 Configuring the Y.1564 Test

Common Y.1564 Test Items
On the control view, click Setting, Y.1564, and then Common Setting to display the following screen.

 

Item Description
Test information

Test name Character string up to 30 characters
Customer Character string up to 30 characters
Operator name Character string up to 30 characters
Comment Character string up to 30 characters

Select Test
Configuration Test

Configuration Test OFF, ON
Test Duration 1 to 60
CIR Test OFF, ON

Step 1 to 7
Min. Rate 1 to 90

EIR Test OFF, ON
Policing Test OFF, ON

M (Margin of the EIR rate) 0.000 to 10000.000 (when unit is IR or UIR), 0.000 to 100.000 (when unit is %)
CBS Test OFF, ON
EBS Test OFF, ON

Performance Test
Performance Test OFF, ON
Test Duration 15 m, 2 h, 24 h, User

When set to User (minutes): 1 to 4320
Unit Setting

Rate Unit IR (effective speed: bps), UIR (utilized information rate), % (ratio of the utilized 
information rate to the Tx rate)

Delay Variation Measurement Previous Frame, Min. Threshold, User
FD Reference 0.000 to 1000.000 (When set to User (ms))
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The Detailed Settings (Service Setup) of the Y.1564 Test
•	 Example	of	the	service	circuit	1
 On the control view, click Setting, Y.1564, Common Setting and then Service1 to display the 

following screen.

 

Item Description
Master, Slave

Enable OFF, ON
Service Type Data, Voice, Video

Data −
Voice G.711, G.729, G.723.1, SDTV (MPEG2)
Video G.711, G.729, G.723.1, SDTV (MPEG2)
Channel number 1 to 367647

Payload Pattern Random, ALL0, ALL1, 0/1 Alternate
Frame Length

Frame Length (byte) 64,	128,	256,	512,	1024,	1280,	1518,	MTU,	User,	EMIX
MTU (byte) 64 to 9000
User (byte) 64 to 9000
EMIX(byte) Number of selectable frame lengths that are registered : 0 to 5

Number of selectable frame lengths : a(64), b(128), c(256), d(512), e(1024), 
f(1280), g(1518), h(MTU), u(User defined)

Color
Color OFF, CoS, ToS, DSCP

Green 0 to 7 (when set to Cos or ToS)
000000 to 111111 (when set to DSCP)

Yellow 0 to 7 (when set to Cos or ToS)
000000 to 111111 (when set to DSCP)

3.11  Configuring the Y.1564 Test
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Item Description
SLA

CIR (Mbps) 0 to 10000
EIR (Mbps) 0 to 10000
CBS (byte) 0 to 1000
EBS (byte) 0 to 1000
FLR (%) 0.00000 to 100.00000
FD (msec) 0.001 to 10000.000
FDV (msec) 0.001 to 10000.000
FDV (%ile) 100, 99.9, 90, 75
AVAIL OFF, ON
AVAIL	[%] 0.001 to 100.000

Address Port Setting  OFF, ON
Source Set the source address.  MAC, VLAN, IPv4, IPv6, UDP
Destination Sets the destination address.  MAC, IPv4, IPv6, UDP

3.11  Configuring the Y.1564 Test
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4.1 Creating New Setup Data and Loading Setup 
Data

Procedure
Creating New Setup Data

1. On the File menu, click Create a new Setup File.

    

A confirmation message is displayed that asks whether you want to discard the current setup data or not.

    

2. Click Yes or No.
•	 To	create	new	setup	data,	click	“Yes,”	and	proceed	to	step	3.
•	 To	keep	the	current	setup	data,	click	“No.”	The	procedure	ends	here.

    

3. Click the Auto, Auto(Remote), Manual, RFC2544, VLAN, or EthernetOAM button to select 
the test that you want to use.
The dialog box closes, and the setup screen for the test that you selected is displayed.

Note
If you select a new test, all the settings are initialized.

Chapter 4 File Operations
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Loading Setup Data
1. On the File menu, click Open Setup File.

    

A confirmation message is displayed that asks whether you want to discard the current setup data or not.

    

2. Click Yes or No.
•	 To	load	setup	data,	click	“Yes,”	and	proceed	to	step	3.
•	 To	keep	the	current	setup	data,	click	“No.”	The	procedure	ends	here.

3. Select the setup file that you want to open, and click Open.

    

The selected file’s data is loaded.

Explanation
Creating New Setup Data
You can create new setup data. However, any changes that you have made to the current data are 
discarded and cannot be restored. Save the current data as necessary. For details on saving setup 
data, see section 4.2.

Loading Setup Data
You can load a saved setup data file and edit its contents. However, any changes that you have made 
to the current data are discarded and cannot be restored. Save the current data as necessary.

File Name Extension
The file name extension is .sd.

4.1  Creating New Setup Data and Loading Setup Data
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4.2 Saving Setup Data

Procedure
Saving Setup Data with a New File Name

1. On the File menu, click Save Setup File as.

    

2. Specify the folder to save to, specify the file name, and click Save to save the file.
Check that the file was saved as a setup file (with the .sd extension).

    

Overwriting Setup Data
After you have saved the setup data, you can overwrite the existing file with the changes that you have 
made to it by clicking “Overwrite Setup File” on the File menu.
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Explanation
Saving Setup Data
You can save setup data as new files or overwrite existing setup data.
Even if you click “Save Setup File as” on the File menu, you can overwrite a setup data file by 
specifying a file name that already exists.

File Name Extension
The file name extension is .sd.

4.2  Saving Setup Data
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4.3 Registering Setup Files to the Select File 
Display and Editing the Select File Display

Procedure
1. On the File menu, click Register Setup File to Select File Display, or on the Display menu, 

click Register Setup File to Select File Display.

    

The Select File Display screen is displayed.

Performing File Operations
2. On the Select File Display screen that appears, click the menus to perform the following 

operations.

    

File menu
•  Create New: Creates a new display data file.
•  Open: Opens a previously registered display 

data file.
•  Save: Saves a registered display data file.
•  Exit: Closes the Select File Display.

Setting menu
•  Set Save Folder: 

Click to set the folder where display data files 
are saved to. You have to select the same 
folder that setup files, which you register by 
using the Select File Display, are saved to. 
The path that you specify is displayed in the 
Save Directory box.

Package file
Compresses the display 
management file (disManage.dmf) 
and the setup files (.sd files) that 
the display management file refers 
to into a single file (***.dmfz).

Registering Setup Files
3. Click No. to make the Add button available. Click Add to display a dialog box, and then use this 

dialog box to specify the setup file to register and a comment for the file.
The setup file that you register must be in the same folder as the folder that you specified for saving display 
data to in step 2.

   

Note
File name: Up to 30 characters (including the extension)
Comment: Up to 30 characters
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Editing Registered Data
4. Select a registered data file, and click the buttons to perform the following operations.

Delete: Deletes the registered data.
Edit: Changes the registered data with a different setup file.
Up: Moves the registered data up one position (No.).
Down: Moves the registered data down one position (No.).
Copy: Copies the registered data.
Paste:  Pastes the copied registered data into the position that the selected No. specifies. If registered 

data already exists in that position, it is overwritten. This button becomes available after you 
click Copy.

Save: Saves a registered display data file. This performs the same function as “Save” in step 2.
Prev. Page: Displays the previous page.
Next Page: Displays the next page.

    

Explanation
You can create the setup file list that is displayed on the Select File Display of the AQ1300/AQ1301.
Information of setup files (.sd) registered in the setup file list is saved in the display management file 
(disManage.dmf).

Version R1.09.01.001 and Later
To	manage	setup	files	and	setup	file	lists	in	projects,	you	can	use	“Create	New	Project	and	New	Setup	
File List” in the Select File Display Data Creation Wizard to create setup file lists. For details, see 
section 4.8.

File Operations
You can carry out various file operations by clicking the commands on the File and Setting menus.
•	 The	data	that	you	have	registered	and	edited	up	to	that	point	is	deleted	if	you:

•	 Create	a	new	file
•	 Open	an	existing	file
•	 Change	the	folder	that	files	are	saved	to

•	 When	you	save	display	data,	the	file	name	is	fixed	to	“disManage.dmf.”
•	 The	folder	that	display	data	is	saved	to	must	be	the	same	folder	that	setup	files,	which	you	register	

by using the Select File Display, are saved to. If these folders are different, you cannot register 
setup files.

Package File
 You can package files on AQ1300/AQ1301 versions R1.06.01.001 and later.

Registering and Editing
You can register up to 4 pages of setup files, 12 setup files on each page. After you have registered a 
setup file, you can change it, change its position (No.), copy it, and delete it.

4.3  Registering Setup Files to the Select File Display and Editing the Select File Display
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Transferring Setup Files to the AQ1300/AQ1301
You can use setup files and setup file list on the AQ1300/AQ1301 in the following ways.

•	 Loading	Files	Using	the	AQ1300/AQ1301	Utility Menu
 For details, see the AQ1300/AQ1301 User’s Manual, IM AQ1300-01EN.

Version R1.09.01.001 and Later
•	 Setup	files	managed	in	projects	can	be	transferred	to	the	AQ1300/AQ1301	using	the	Trans. Setup 

File	button	in	the	Project	dialog	box.
 For details, see section 4.9.

Note
To manually copy setup files that are not managed in projects
Be sure to copy the display management file (disManage.dmf) and the setup files (.sd files) that the display 
manage file refers to into the AQ1300/AQ1301 /setup directory.

Example: /setup/disManage.dmf
   /setup0000.sd
   /setup0001.sd
   :

4.3  Registering Setup Files to the Select File Display and Editing the Select File Display
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4.4 Opening Statistical Result Files

Procedure
Opening Statistical Result Files

1. On the File menu, click Open Measurement Result File.

    

A confirmation message is displayed that asks whether you want to discard the current setup data or not.

2. Click Yes or No.
•	 To	load	a	statistical	result,	click	“Yes,”	and	proceed	to	step	3.
•	 To	keep	the	current	setup	data,	click	“No.”	The	procedure	ends	here.

    

3. Select the statistical result file that you want to open, and click Open.
The selected statistical result file data is loaded.
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Displaying the Statistical Result Screen
4. The statistical result screen or test result summary screen appears.

Auto test or Auto(Remote) test Execution type: Single
Execution type: Continuous, File save type: Separate

Manual test

  

When you set Display 
Type to “Unit of page,” 
the buttons that are used 
to switch between pages 
become available.

• Rate Unit Switch
• Traffic Switch
• QoS Switch
When you change the 
Form setting and these 
settings become available, 
you can change them.

Select the display format (Test Result, Tx/Rx Comparison Display, 
Custom Display, Detail Display).

Select the display 
method (All Items, 
Unit of page).

Statistical result screen

Auto test or Auto(Remote) test Execution type: Continuous, File save type: Consolidate
(Supported in version R1.08.01.001 and later)

RFC2544 Test

In the control view, select the statistical result to display

Test result 
summary screen
You can check test 
items and pass/fail 
judgments.

Statistical result 
screen 
(example of traffic)
For details on how to 
use this screen, see 
the statistical result 
screen in the 
previous section.

Select the statistical 
result to display.

RFC2544 Test

* For details on the test result screens of the RFC2544 test, see the user’s manual, IM AQ1300-01EN.

4.4  Opening Statistical Result Files
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VLAN Test (Supported in version R1.09.01.001 and later)

In the control view, select the VLAN test result.

—
—

ID Rx status MAP display List display
Success
Fail
Error
Monitor
None
Other

Green
Orange
Red
Blue
White
Gray

Color

VLAN test result screen (MAP display)Test result summary screen

Expand display buttons
Expands the map and 
displays 255 IDs starting 
with the ID indicated on 
the button

All Area button
Valid when the map is 
displayed expanded. 
Switches to the all map 
display.

List display

Move button
Moves to the VLAN ID (0 to 4095) entered in the left box.
The line containing the entered VLAN ID is highlighted.

Set what to display
(All, Success, Fail, 
Error).

Select Result 
VLAN Test.

* For details on the VLAN test result screen, see “Explanation” in section 11.8 in the user’s manual IM 
AQ1300-01EN.

4.4  Opening Statistical Result Files
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Ethernet OAM Test (Supported in version R1.10.01.001 and later)

In the control view, select the LB Detail result.

Select LB 
Detail result.

Test result 
summary screen
You can check test 
items.

LB Detail result
You can check the 
statistical result.

4.4  Opening Statistical Result Files
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In the control view, select the CC Detail result.

Select CC 
Detail result.

CC Detail result
You can check the 
statistical result.

4.4  Opening Statistical Result Files
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Y.1564 Test (Supported in version R1.11.01.001 and later)

In the control view, select Test Result Summary.

 

Test Result Summary 
window
You can view the results 
of the test items.

Select Test 
Result Summary.

In the control view, select IR Test.

 

Select the statistical 
result to display.

IR step load test result display window
You can view the CIR and EIR test results.

4.4  Opening Statistical Result Files
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In the control view, select BS	Test.

 

Select the statistical 
result to display.

Burst size test result display window
You can view the CBS and EBS test results.

In the control view, select Service Performance.

 

Select the statistical 
result to display.

Service performance test result display window
You can view the test results of all service lines.

4.4  Opening Statistical Result Files



4-15IM AQ1300-61EN

File O
perations

1

2

3

4

5

Explanation
Loading Statistical Results
You can open and display statistical result files that have been created on the AQ1300/AQ1301. 
However, any changes that you have made to the current data are discarded and cannot be restored. 
Save the current data as necessary.
For details on the items that are displayed in a statistical result, see the user’s manual, 
IM AQ1300-01EN.

Note
The following items are added to statistical results files that have been processed by AQ1300s whose 
firmware version is R1.05.01.001 or later.
•	 Test	item	number	(1	to	8)	at	the	time	of	measurement
•	 System	version	at	the	time	of	measurement
•	 VLAN	stacks	at	the	time	of	measurement
•	 Interface	information	at	the	time	of	measurement

 Test interface, Optical module type, Optical module vendor, 
 Optical module model name (identification of optical modules that are not recommended)

File Name Extension
The file name extension is .mr.

4.4  Opening Statistical Result Files
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4.5 Exporting Statistical Results to CSV Files

Procedure
Exporting Statistical Results to CSV Files

1. While a statistical results file is open, on the File menu, click Output a Measurement Result 
File in a CSV File.
If you do not open and display a statistical result file by following the procedure in section 4.4, Output a 
Measurement Result File in a CSV File is unavailable.

    

Saving Data as CSV Files
2. Specify the folder to save to, specify the file name, and click Save to save the file.

Check that the file was saved as a statistical result file (with the .csv extension).
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Explanation
Generating CSV from Statistical Results
You can save the data in AQ1300/AQ1301 statistical result files in CSV format.
If you do not open and display an AQ1300/AQ1301 statistical result file, you cannot perform this 
operation.

Output Example
The following example shows the saved data being displayed in a spreadsheet program.

  

4.5  Exporting Statistical Results to CSV Files
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4.6 Starting the FTP Client

Procedure
Starting the FTP Client

1. On the File menu, click FTP Client.

    

Configuring the Connection
2. On the Connect menu, click Connect. The List of Host screen is displayed. Select the host that 

you want to connect to, and then click Modify to configure the host settings.

    

Connecting to a Host
3. On the List of Host screen, click Connect.

Explanation
The setup software has an FTP client feature.
•	 You	can	transfer	data	between	the	client	and	FTP	servers	(upload	and	download).
•	 Ask	the	host’s	administrator	for	the	settings	of	the	host	that	you	want	to	connect	to,	such	as	the	

address (Host), user name, and password.
•	 When	you	start	the	FTP	client,	you	can	also	select	Quick	Connect	on	the	Connect	menu	to	perform	

a quick connection.
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4.7 Using the Simple Test Setting Auto Wizard

Procedure
1. On the File menu, click Create a new Setup File.

    

A confirmation message is displayed that asks whether you want to discard the current setup data.

2. Click Yes or No.
•	 To	use	the	wizard	to	create	new	setup	data,	click	Yes, and proceed to step 3.
•	 To	keep	the	current	setup	data,	click	No. The procedure ends here.

3. Click Simple Test Setting Auto.

    

The dialog box closes, and the wizard appears.

4. Follow the instructions in the wizard, and set values for the items.
You can configure the following settings in the wizard.
•	 Test	settings
•	 Link	settings
•	 Address	settings
•	 Test	items
•	 Option	settings
•	 File	name	settings
At the end of the wizard, a screen for confirming the settings will appear.

When you click Next on this screen, a message appears to confirm whether you want to open the detail 
setup screen.

    

5. Click Yes or No.
•	 To	close	the	wizard	and	open	the	detail	setup	screen,	click	Yes. The wizard closes, and the detail setup 

screen for the test items you configured in the wizard appears.
•	 If	 you	do	not	want	 to	 close	 the	wizard,	 click	No to return to the wizard and continue configuring the 

settings.



4-20 IM AQ1300-61EN

4.8 Using the Select File Display Data Creation 
Wizard

Procedure
1. On the File menu, click Create a new Setup File.

    

A confirmation message is displayed that asks whether you want to discard the current setup data or not.

2. Click Yes or No.
•	 To	use	the	wizard	to	create	new	setup	data,	click	Yes, and proceed to step 3.
•	 To	keep	the	current	setup	data,	click	No. The procedure ends here.

3. Click Simple List File Setting.

    

The dialog box closes, and the wizard appears.

Selecting the Creation Method
4. Click the creation method you want to use.

 Depending on the method that you have chosen, configure the following settings.

  

Specify the location of the new folder. 

From the drop-down list, select the 
project. 

Enter the project name, and click OK. 
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Editing the Setup File List Data
5. Follow the instructions in the wizard to set the items.

At the end of the wizard, a screen for confirming the settings will appear.

Checking the Edited Settings
6. Check the settings, and click Save.

Creating a Package File
7. Click Complete.

A confirmation message is displayed that asks whether you want to create the package file.

   

Finishes the wizard without 
creating the package file. 

 

8. Enter the package file name, and click Save.
The following confirmation screen appears.

   

Explanation
You can create the setup file list that is displayed on the Select Setup File Screen of the AQ1300/
AQ1301	as	projects.
To	create	a	project	by	loading	an	existing	setup	file	(.sd),	specify	an	existing	display	management	file1 
(disManage.dmf) or package file2	(.dmfz),	and	create	a	new	project.

A	display	management	file	or	a	package	file	is	managed	as	a	project.	For	details,	see	section	4.9.
1  A display management file (disManage.dmf) contains information of setup files (.sd) registered in 

the setup file list.
2 A package file (.dmfz) is a single compressed file consisting of a display management file (disManage.

dmf) and the registered setup file (.sd).

4.8  Using the Select File Display Data Creation Wizard
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4.9 Managing Setup Files and Result Files

This feature is supported in version R1.09.01.001 and later.

Procedure
Creating a New Project

1.  On the File menu, click Create a new Setup File.

   

A confirmation message is displayed that asks whether you want to discard the current setup data.

   
No 
Click to keep the current setup data. 
If necessary, save the current setup data (see section 4.3). 

 

2.  Click Yes.
The current setup data is discarded, and the Measurement dialog box appears.

   

3.  Click Project New.
The	Project	Setting	dialog	box	appears.

   

Project Name 
Enter a project name of your choice. 

Browse for setup files. 
Specify a setup file list 
(disManage.dmf) or 
package file (.dmfz). 

4.  Click OK.
A	new	project	is	created,	and	the	dialog	box	closes.	You	can	edit	the	new	project	in	the	Project	dialog	box	
explained in the next section.
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Managing Projects
1.  On the Display menu, click Project Manage.

   

The	Project	dialog	box	appears.

Project	Dialog	Box
•		 Configuring	a	Project
 Click the Project tab. The following screen appears.

  

Select a project 
Select a project that you want to use from the projects registered in the PC. 

Displays information 
about the statistical result 
file that has been retrieved 

Displays the location of 
the current display 
management file 
or package file 

File transfer
Transfer files between the PC
and the AQ1300/AQ1301.

Edit 
Change the project setup 
file list.  

 File Transfer

  

Trans. Setup File
Transfers the project setup file (.sd) and display management file (disManage.dmf) or 
a package file (.dmfz) from the PC to the specified the AQ1300/AQ1301.

Update 
Updates the host list 

Get Result File
Transfers the statistical result file or result file (.mr) from the specified 
the AQ1300/AQ1301 to the PC.

Host List
If there are several the AQ1300/AQ1301 that you can 
connect to, select the one to transfer files to.

4.9  Managing Setup Files and Result Files
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•		 Device	Connection	Settings
 Click the Device tab. The following screen appears.

 Configure how to connect to the AQ1300/AQ1301.

   

When Connect Setting is 
ETHERNET
Configure the following items:
• Select the AQ1300/AQ1301 

to connect to.
• IP address
• User name
• Password
• Host name

When Connect Setting is 
USBTMC 
Displays the host connected via 
USBTMC 

Retrieves the AQ1300/AQ1301 
host name and displays it in the 
Host Name box

Select the method to connect 
to the AQ1300/AQ1301.

Connects to the host selected in 
the Host List and displays its 
information 
• Model Name 
• Serial Number 
• Host Name 
• USB Serial Number  
  (for USBTMC) 

•		 Configuration
 Click the Configuration tab. The following screen appears.

	 You	can	change	the	root	project	folder	to	any	folder	of	your	choice.
The root project folder for the first installation
•	 If	you	using	Windows	XP,	Shared	Documents/Yokogawa/AQ1300
•	 If you using Windows Vista or later, Public Documents/Yokogawa/AQ1300

   

Select the root project folder. 

4.9  Managing Setup Files and Result Files
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Explanation
Managing Projects
A pair of setup and display management files1 or a package file2	is	managed	as	a	project.	All	projects	
are	managed	in	the	root	project	folder.
1   Display management files (disManage.dmf) contain information of setup files (.sd) registered in the setup file 

list.
2   A package file (.dmfz) is a single compressed file consisting of a display management file (disManage.dmf) and 

the registered setup file (.sd).

File Structure
If a Project Is Created Using “Create New Project and New Setup File List” in the 
Select File Display Data Creation Wizard

	 The	setup	file	list	is	managed	in	the	setup	folder	under	the	newly	created	project.
 For details on the Select File Display Data Creation Wizard, see section 4.8.

AQ1300 (root project folder*) 
Yokogawa 

Project A  

Shared (Public) Documents 

setup 

disManage.dmf (display management file) 

***.sd (setup file 1) 

***.sd (setup file 2) 

*   The root project folder for the first installation. 
 • If you using Windows XP, Shared Documents/Yokogawa/AQ1300 
 • If you using Windows Vista or later, Public Documents/Yokogawa/AQ1300 
 You can change this folder to any folder on the Configuration tab in the Project dialog box. 

PC 

If	a	Display	Management	File	or	Package	File	is	Specified	in	the	Project	Dialog	Box	for	
Creating a New Project

	 The	display	management	file	and	package	file	in	the	specified	location	is	managed	by	the	project.	
*		 Files	that	are	not	in	the	root	project	folder	can	be	used.

Location of your choice 

disManage.dmf (display management file) 

***.sd (setup file 1) 

***.sd (setup file 2) 

or 

***.dmfz (package file) 

PC 

4.9  Managing Setup Files and Result Files
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Trans. Setup File
The	setup	file	and	display	management	file	of	the	project	selected	on	the	PC	are	transferred	to	the	
setup folder in the AQ1300/AQ1301.
If	a	package	file	was	selected	when	the	project	was	created,	the	package	file	is	sent	to	the	AQ1300/
AQ1301 and uncompressed in the setup folder.
*  When you click Trans. Setup File, an overwrite confirmation message will appear. 

If you select Yes, the setup file list on the AQ1300/AQ1301 is overwritten with that on the PC.

Get Result File
The statistical result file (.mr) and the result folder are copied from the specified AQ1300/1301 to the 
PC. The file and folder are saved in a folder identified by the host name or serial number in the result 
folder	of	the	selected	project.
*  When you click Get Result File, an overwrite confirmation message will appear. 

Selecting Yes will copy the statistical result file to the PC. If a file with the same name exists, it will 
be overwritten.

*  When the transferring of the result file is complete, a confirmation message is displayed that asks 
whether you want to delete the statistical result file on the AQ1300/AQ1301. If you select Yes, the 
file and folder in the result folder of the AQ1300/AQ1301 will be deleted.

 

Internal Memory AQ1300 (root project folder) 
Yokogawa 

result
Project A  

Project B  
Project C  

MFT_#01 (host name or serial number) 

Shared (Public) Documents 

result 

***.mr (statistical result file 3) 

***.mr (statistical result file 1) 

***.mr (statistical result file 2) 

MFT_#02 (host name or serial number) 

***.mr (statistical result file 3) 

***.mr (statistical result file 4) 

***.mr (statistical result file 5) 
Folder_a 

Folder_a 

***.mr (statistical result file 4) 

***.mr (statistical result file 5) 

result 

***.mr (statistical result file 1) 

***.mr (statistical result file 2) 

Internal Memory 

PC MFT_#01
AQ1300/AQ1301

MFT_#02
AQ1300/AQ1301

Get 
Result file 

 

Get 
Result file 

 

4.9  Managing Setup Files and Result Files
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Error Messages
An	error	message	may	appear	when	you	create	a	new	project	or	while	you	edit	in	the	Project	dialog	
box. This section describes the error messages and how to respond to them.

Message Corrective Action
Please	enter	Project	Name. •	Enter	the	project	name.
Contains a character that can not be used in 
Project	Name.

•		Check	that	the	following	characters	are	not	included	in	the	
project	name.

¥, /, :, *, ?, ", <, >, or |
Failure	to	create	the	project.
This	project	already	exists.

•		Project	names	already	registered	cannot	be	used.	Register	with	
another name.

•		Delete	the	project	that	is	already	registered,	and	then	register	
again.

Please select Setup File List. •	Check	that	the	setup	file	is	selected.
Project	is	not	registered.
Please	do	create	a	new	project	from	Top	Dialog.

•		Check	that	the	project	is	registered.	If	not,	register	it	from	the	
project	setup	screen. 
You	can	start	the	project	setup	screen	from	the	Measurement	
dialog box.

Please select Device. •	Select	a	host	from	the	host	list	first.
Setup File List does not exist. •		Check	that	the	setup	file	list	exists	in	the	setup	file	list	storage	

location. If it does not, select the setup file list again.
Comm has time out. •		Check	that	a	connection	is	established	with	the	AQ1300/

AQ1301.
•		Check	that	the	connection	method	(USBTMC	or	ETHERNET)	is	

correct.
•		Check	that	the	IP	address,	username,	and	password	are	the	
same as those on the AQ1300/AQ1301.

Wrong Device. •		Check	that	the	connected	host	is	an	AQ1300	or	AQ1301.
Firmware is not compatible. •		Check	that	the	version	of	the	connected	host	is	1.09	or	later.
Comm error has occurred. •		Check	that	a	connection	is	established	with	the	AQ1300/

AQ1301.
•		Remove	the	cable	connected	to	the	AQ1300/AQ1301	once,	and	
reconnect it.

Please select the Measurement Result File. •	Select	a	statistical	result	file.
Please enter User. •	Enter	the	username.
User can not be used characters are used. •		Check	that	the	following	characters	are	not	included	in	the	

username.
Characters other than alphanumeric characters

Password can not be used characters are used. •		Check	that	the	following	characters	are	not	included	in	the	
password.

Characters other than alphanumeric characters
Please enter Host Name. •	Enter	the	host	name.
It is a device registered. 
Please delete or set a different name.

•		Host	names	already	registered	cannot	be	used.	Register	with	
another name.

•		Delete	the	host	name	that	is	already	registered,	and	then	
register again.

Host Name can not be used characters are 
used.

•		Check	that	the	following	characters	are	not	included	in	the	host	
name.

Characters other than alphanumeric characters, ¥, /, :, *, ?, ", 
<, >, or |

4.9  Managing Setup Files and Result Files
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4.10 Exporting the Statistical Results of an RFC2544 
Test and a Y.1564 Test to PDF

Procedure
1. On the File menu, click Output a Measurement Result File in a PDF File.

If you do not open and display a statistical result file by following the procedure in section 4.4, Output a 
Measurement Result File in a PDF File is unavailable.

    

The PDF export dialog box appear. 

    

Select this check box to insert a logo into the PDF file’s header 
(see page 4-25) 
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Exporting a PDF File without a Logo in the Header
2. Specify the folder to save to, specify the file name, and click Save to save the file.

 Check that the file was saved as a PDF file (with the .pdf extension).

Output Example (RFC2544 Test)
The following example shows the saved data being displayed in a PDF reader application.

  

4.10  Exporting the Statistical Results of an RFC2544 Test and a Y.1564 Test to PDF



4-30 IM AQ1300-61EN

Exporting a PDF File with a Logo in the Header
You can insert a logo into the header of the PDF file.

2. After step 1 on page 4-23, select the Include a logo in the report check box, and click Select 
a logo image.

    

3. Select the image file of the logo that you want to insert, and click Open.
The	file	types	that	you	can	choose	from	are	JPEG	and	PNG.	The	size	of	the	image	can	be	up	to	300	×	100	
pixels.

    

4. The logo that you selected appears in the bottom of the PDF export dialog box.

    

5. Specify the folder to save to, specify the file name, and click Save to save the file.

Example of an Inserted Logo

    

4.10  Exporting the Statistical Results of an RFC2544 Test to PDF
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4.11 Exporting the Graph Images of the Statistical 
Results of an RFC2544 Test

 Procedure
1. On the File menu, click Output RFC2544 Graphs in Image Files.

If you do not open and display a statistical result file by following the procedure in section 4.4, Output 
RFC2544 Graphs in Image Files is unavailable.

    

2. Specify the folder to save to, specify the base file name, and click Save to save the file.

    

Note
•	 The	image	file	formats	that	you	can	save	to	are	bitmap	(24	bit),	JPEG,	and	PNG.
•	 The	files	are	saved	to	the	specified	location	with	the	following	names:	[The	base	name	you	entered]_[The	

test	item	name].[The	extension].	One	file	is	saved	for	each	selected	test	item.
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4.12 Importing and Exporting Setup Text Files

This feature is supported in version R1.08.01.001 and later.

Procedure
Importing a Setup Text File

1. On the File menu, click Import.
A confirmation message is displayed that asks whether you want to discard the current setup data.

   

2. Click Yes or No.
•	 To	import	the	setup	text	file,	click	Yes.	Proceed	to	step	3.
•	 To	keep	the	current	setup	data,	click	No.	The	procedure	ends	here.

   

3. Select the setup text file, and click Open.
The selected setup text file is imported.
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Exporting a Setup Text File
1. On the File menu, click Export.

   

2. Specify the folder to save to, specify the file name, and click Save to save the file. 
Check that the file was saved as a setup text file (with the .ini extension).

   

Explanation
Importing a Setup Text File
You can import a setup text file that you edited on an external device. Note that when you import a file, 
any changes that you have made to the current data are discarded and cannot be restored. Save the 
current data as necessary. For details on saving setup data, see section 4.2.
The extension of setup text files is .ini.

Note
•	 When	creating	a	setup	text	file,	use	ANSI	or	Shift-JIS	for	the	character	encoding.
 Depending on the OS, double-byte characters may not be recognized.
 In such case, replace double-byte characters with single-byte characters.
•	 Items	that	are	not	specified	in	setup	text	files	are	set	to	their	default	values.
•	 To	load	a	Frame	Builder	setup	file	(.frb	extension)	in	a	manual	test,	place	the	file	in	the	same	folder	as	the	

setup text file (.ini extension).

Exporting a Setup Text File
The extension of setup text files is .ini.
In a manual test, a Frame Builder setup file (.frb extension) is exported in addition to the setup text file.
An example of a setup text file opened in a text editor is shown next.

4.12  Importing and Exporting Setup Text Files
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•	 Setup	Text	File	Example

   

Error Messages
An error message may appear when you are importing or exporting a setup text file. This section 
describes the error messages and how to respond to them. Some messages indicate the line number 
in the setup text file where there is an error. Check the indicated line.

Message Corrective Action
The setup file Load Error Check whether the specified file exists in the folder. Check 

that the file name extension is .ini.
The setup file Save Error Check whether the specified folder exists. Check that the file 

name extension is .ini.
Selected unrecognized SECTION. Check	whether	the	test	type	(TEST_TYPE)	is	specified	

correctly. 
Test types:  Auto, Auto(Remote), Manual, RFC2544, and VLAN

Selected unrecognized PARAMETER. Enter only one equal sign in the parameter syntax. If you 
enter more than one, an error will occur.

There is no entry required. Check that version information (VERSION) is specified.
Test category does not exist. Specify	the	test	type	(TEST_TYPE).	

Test types:  Auto, Auto(Remote), Manual, RFC2544, and VLAN
Cannot Load, because the version is different. This	software	does	not	support	the	major	version	specified	

in the file. Check the supported version. For details on the 
version information, see section 5.3.

Is a supported version. The middle version is different. This software may not support 
some of the functions specified in the file. Check the version. 
For details on the version information, see section 5.3.

It is not a string of numeric format. Specify the parameter using numbers (decimals).
It is not a string of hexadecimal format. Specify the parameter in hexadecimals. Attach “0x” to the 

front of numbers. Example: 0x1a
It is not a string of integer format. Specify the parameter using a positive number.
String data is not appropriate. If the parameter requires one of the available options to be 

specified, do so.
More than a 30 digit string has been specified. Specify parameters using 30 characters or less.
Frame Builder files is illegal. There is a syntax error in the Frame Builder setup file (.frb 

extension). Do not edit Frame Builder setup files using a text 
editor. Use the Frame Builder software for this purpose.

File Not Found Frame File. Place the Frame Builder setup file (.frb extension) in the 
same folder as the setup text file (.ini extension).

4.12  Importing and Exporting Setup Text Files
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5.1	 Standard	Bar,	Control	View,	and	Status	Bar

Features marked with an asterisk are not supported in software version R1.09.01.001 and later.

Procedure
Showing	and	Hiding	the	Standard	Bar*

 On the Display menu, click Toolbar Docking Window, and then click standard.
If a check mark is displayed next to “standard,” the standard bar is shown. If you carry out this procedure 
when the check mark is displayed, the standard bar is hidden. If you carry out this procedure when the 
check mark is not displayed, the standard bar is shown.

    

Showing and Hiding the Control View*

 On the Display menu, click Toolbar Docking Window, and then click Control View.
If a check mark is displayed next to “Control View,” the control view is shown. If you carry out this procedure 
when the check mark is displayed, the control view is hidden. If you carry out this procedure when the 
check mark is not displayed, the control view is shown.

    

Operations	that	Can	Be	Performed	on	the	Control	View
	 Click	the	▼	icon	on	the	control	view	to	display	a	menu.	By	selecting	commands	in	this	menu,	

you can change control view settings such as its position and whether the control view is shown 
or hidden.

    

 If you press the  icon on the control view, the control view collapses to the left edge of the 
window.

    

 To expand the collapsed control view, move your mouse pointer over the control view’s title bar 
to expand the control view, and then click the  icon.

    

Chapter 5 Screen Operations
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Showing	and	Hiding	the	Status	Bar
 On the Display menu, click Statusbar.

If a check mark is displayed next to “Statusbar,” the status bar is shown. If you carry out this procedure 
when the check mark is displayed, the status bar is hidden. If you carry out this procedure when the check 
mark is not displayed, the status bar is shown.

    

Explanation
Display Menu in Software Version R1.09.01.001 and Later

 You can show or hide the status bar.
 For details on other menus, see the relevant sections indicated below.

•	 Registering Setup Files to the Select File Display Section 4.3
•	 Managing	Projects	 Section	4.9

Display Menu before Software Version R1.09.01.001
 You can show and hide the standard bar, control view, and status bar.
 There is also a “customize” command on the submenu that opens when you click “Toolbar Docking 

Window” on the Display menu. The customize screen has the following tabs: Commands, Toolbars, 
Keyboard, Menu, and Options. You can change the settings on these tabs as necessary.

5.1		Standard	Bar,	Control	View,	and	Status	Bar
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5.2 Showing Cascaded and Tiled Screens and 
Selecting Which Screen to Display

This section explains the commands that you can use when multiple setup or test screens are open.

Procedure
Cascaded Screens

 On the Window menu, click Cascade.

    

 Example

    

Tiled Screens
 On the Window menu, click Tile Horizontally or Tile Vertically.

    

 Example (Tile horizontally)
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 Example (Tile vertically)

    

Selecting Which Screen to Display
 On the Window menu, select the screen that you want to display from the list of screens.

The selected screen is displayed on top of all other screens.

    

Explanation
When multiple setup or test screens are displayed, you can arrange the screens and select which 
screen is displayed on top (the current window).

5.2  Showing Cascaded and Tiled Screens and Selecting Which Screen to Display
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5.3 Viewing the Software Version

Procedure
 On the Help menu, click Version Info.

The Version Information dialog box appears.

    

Explanation
Version information is managed in the following manner.
If a version related error message appears while using the software, check the relevant section of the 
version number below.

 

R1.09.01.001

Major version

Middle version

Minor version


	Terms and Conditions of the Software License
	Conventions Used in This Manual
	Notes about Using This Software

	Contents
	Chapter 1	Features
	1.1	Test Configuration
	1.2	List of Features
	1.3	Features
	1.4	Screen Explanation

	Chapter 2	Starting and Closing the Software
	2.1	Starting and Closing the Software
	2.2	Changing the Test

	Chapter 3	Setup Procedure
	3.1	Basic Operations
	3.2	Making Items Editable from the AQ1300/AQ1301
	3.3	Setting Tables
	3.4	Setting Statistics Display Items for Auto, Auto(Remote), and Manual Tests
	3.5	Setting Selected Test Items for Auto, Auto(Remote), and RFC2544 Tests
	3.6	Setting Pass/Fail Judgment Conditions for Auto, Auto(Remote), and RFC2544 Tests
	3.7	Using Frame Builder for Manual Tests
	3.8	RFC2544 Test Result Display
	3.9 	Configuring the VLAN Test
	3.10	Configuring the Ethenet OAM Test
	3.11	Configuring the Y.1564 Test

	Chapter 4	File Operations
	4.1	Creating New Setup Data and Loading Setup Data
	4.2	Saving Setup Data
	4.3	Registering Setup Files to the Select File Display and Editing the Select File Display
	4.4	Opening Statistical Result Files
	4.5	Exporting Statistical Results to CSV Files
	4.6	Starting the FTP Client
	4.7	Using the Simple Test Setting Auto Wizard
	4.8	Using the Select File Display Data Creation Wizard
	4.9	Managing Setup Files and Result Files
	4.10	Exporting the Statistical Results of an RFC2544 Test and a Y.1564 Test to PDF
	4.11	Exporting the Graph Images of the Statistical Results of an RFC2544 Test
	4.12	Importing and Exporting Setup Text Files

	Chapter 5	Screen Operations
	5.1	Standard Bar, Control View, and Status Bar
	5.2	Showing Cascaded and Tiled Screens and Selecting Which Screen to Display
	5.3	Viewing the Software Version


